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Overview

Overview

This guide presents year-end processing guidelines for Deltek Costpoint.

Note: See the Deltek Costpoint Frequently Asked Questions document for related information.

Adding Custom Notes to This Guide

If you would like to add custom notes to this guide that are specific to your company, Adobe® Reader® X
provides this ability. If you do not already use Adobe Reader X, you can download it here free from
Adobe.

To add a custom note using Adobe Reader X:

1. On the Reader toolbar, click Comment at the far right.

2. In the Annotations pane that displays, click Q Sticky Note. The cursor changes to match the
button.

3. Position the cursor at the location in the guide where you want the note to appear, and click. A
note icon is inserted at the location and a text box pops up.

4. Enter your information in the text box.
Continue adding notes as needed.

6. Save the document.

Note: Deltek recommends that you save the document to a slightly different filename to keep the
original from being overwritten.

When reading the document, cursor over a note icon to see the information. Double-click a note icon to
edit the information.

Deltek Support Center

To expedite our responses to your questions at year end, we encourage you to use the Deltek Support
Center, https://deltek.custhelp.com, where you can enter incidents on the Ask Support page or start a live
chat with one of our analysts.

Click the link below to view Year-End Resources, located on the Support Center home page. This site will
be updated continuously through February and will contain information such as Year-End Bulletins,
FAQs, links to the product releases, additional services that are offered for year-end, and up-to-date tax
changes.

You need a valid Deltek Support Center login to access this site:

https://deltek.custhelp.com/app/YearEnd

Alternatively, you can contact Deltek Customer Care by calling 1.877.457.7765.
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Chapter 1: What's New

Chapter 1: What's New
1099 Changes

There have been formatting changes to all copies of the 1099 Forms for 2021.

W-2 Form Changes

There are no changes to the W-2 Form for 2021.

W-2 Box 12 Codes

There are no Box 12 additions for 2021.

USERRA Codes

The following USERRA codes have been added to the Edit W-2 Information/Box 12 Lookup field:

D 19: USERRA 2020 make up elective deferrals to a section 401(k) cash or deferred
arrangement.

E 19: USERRA 2020 make up elective deferrals to a section 403(b) salary reduction agreement.

F 19: USERRA 2020 make up elective deferrals to a section 408(k)(6) salary reduction
agreement.

G 19: USERRA 2020 make up elective deferrals and employer contributions (including non-
elective deferrals) to a section 457(b) deferred comp plan.

H 19: USERRA 2020 make up elective deferrals under a section 501(c)(18)(D) tax-exempt
organization plan.

S 19: USERRA 2020 make up employee salary reduction contributions under a section 408(p)
SIMPLE.

Y 19: USERRA 2020 make up deferrals under section 409A non-qualified deferred
compensation plan.

AA 19: USERRA 2020 make up designated Roth contributions to a section 401(k) plan.

BB 19: USERRA 2020 make up designated Roth contributions under a section 403(b) salary
reduction agreement.

EE 19: USERRA 2020 make up designated Roth contributions under a section 457(b) plan.

EFW2 Filing (Electronic Filing of W-2 Forms)

There are no record layout changes for Tax Year 2021. Current Costpoint supports the electronical filing
of W-2 but not W-2 C. This enhancement is being developed for tax year 2022.

State Electronic Filing

Electronic filing updates were added for Indiana.
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Note: Most states have not yet updated their W-2 electronic filing specifications for Tax Year 2022 at
time of printing.

Federal Regulatory Updates

Please see the Release Notes for a full recap of all changes.

Product Changes

Please see the Release Notes for a full recap of all changes.

Costpoint Information Center

https://help.deltek.com/Product/Costpoint/Documentation/Costpoint Release Documentation.html

Table of Contents

Costpoint Information Center (CIC) ~
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Year-End Guide 3


https://help.deltek.com/Product/Costpoint/Documentation/Costpoint_Release_Documentation.html

Deltek

Chapter 2: Ordering Forms

Chapter 2: Ordering Forms

For information about vendors that work with Deltek, complete the following steps to view the
vendor page on the Deltek website:

1. Go to http://www.deltek.com.
2. Click Partners.

3. Select Find a Partner, and then select Product Partner Marketplace. Search for “Forms.” And
then, click Forms Fulfillment Center.
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Chapter 3: Accounts Payable Processing

1099 Tracking and Posting Checklist

Use the following checklist as you complete your year-end steps for 1099 tracking and posting.

1. During vendor setup, designate vendors as 1099 Reportable on the Vendor
Info screen.

2. Enter vouchers (voucher lines or expense lines flagged as 1099 with 1099
type).

3. Post vouchers.

4, Print checks and post cash disbursements.

5. In December 2021: Install the Costpoint Calendar Year-End (CYE) Regulatory
Update.

6. Order 1099-MISC/1099-NEC forms.
7. Create 1099 information for calendar year 2021.
8. Print the 1099 Edit Report.

9. Review the 1099 Edit Report to check the vendors’ Tax ID/Social Security
numbers.

10. Make necessary corrections in Costpoint, on the Manage Vendor History
screen.

11. Create 1099 information.
12. Print the 1099 Edit Report again to check your corrections.

13. Optional: Print 1099s on blank paper to review vendor addresses and
alignment.

14. Print 1099s.

15. Create the Magnetic Media File (to be transmitted electronically), if required for
your company.

1099 Form Changes
= No form changes for 1099 MISC or 1099 MISC Self-Mailer.
= Form changes for 1099 NEC and 1099 NEC Self-Mailer.
= 1099 NEC:
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= Now 3 forms per page. One Address Line for the Recipient on Copy A.
= Box 1is NONEMP. (Same as 2020)

= Box2is Sales. (New for 2021)

= Box4is FED. (Same as 2020)

= 1099 NEC Self-Mailer: Form is basically the same, but the layout has changed to add Box 2 and
move Box 4.

= Box 1is NONEMP. (Same as 2020)
= Box 2 is Sales. (New for 2021)
= Box4is FED. (Same as 2020)

Manage Vendors Screen
To define the 1099-MISC type, go to the Manage Vendors screen and complete the 1099’s section.

# % [I Browse Applications > Accounting > Accounts Payable > Vendors > Manage Vendors (U]

Identification New ][ Copy | v [ Detete || tacn || approval | [1][ < ][ or1 exsama [ ][ ][] Tavie | Sl m ][ — ][ x |

Vendor ID 1099NON Name * 1099 NON EMPLOYE! Location
Header Defaults | Notes
Long Name* 1099 NON EMPLOYEE Vender Group 1099's
- Print 1099-MISC Form
Vendor Web Site Customer Account )
Vendor Status EopmEe | Type [NONEMP hd
® Active [ Hold Payments Tax ID 52-0223375
- DUNS Number 1099
D) Give Warning [ Payroll Vendor Neme 1099 NON EMPLOYEE
- UEI Number
O Inactive s
Time Collection
Vendor Approval APPROVED Expense Class

GovWin 1Q Company Information
GovWin IQ Company ID Last GovWin 1Q Synch Last GovlWin 1Q Analyst Update
Do Not Refresh

Subcontractor Management
Entry
User DELTEK Date 06/12/2001 Password

[] Subcontractor Vendor Employee |

Approval Group

Vendor Employees Vendor Classification Currencies Subcontractor Info  Credit Card Info  Addresses Default Expense Accounts VAT Info CIS Info  User-Defined Info

Identification > Addresses te || Form || Query

[ Address Address ‘Address Address State/ Postal Ship ID Payment Order Phone | Fax | Other g Sales/Use
Code * Line 1 Line 2 Line 3 City _ Province  Code | Couniry ShipID Description Address™ | Address™  Number Number Number A District Code _Tax Code
BILLING |lADDRESSLINE#! |ADDRESSLINE#2 |ADDRESSLINE#3 [MCLEAN |VA 22209 USA Default v |Default v VA

[« »

The 1099-MISC type selected on the Manage Vendors screen defaults on every voucher line for that
vendor.

You can edit the 1099-MISC type:
= At the voucher line level on the Manage A/P Vouchers and Manage PO Vouchers screens
= On the Manage Vendor History screen
= On the Edit 1099 Information Screen
If you select the Print 1099-MISC Form check box, then the 1099 check box on the Manage A/P
Vouchers and Manage PO Vouchers screens defaults to selected on each expense line.

The Vendor 1099 Name prints on the 1099 and appears in the file created by the Create 1099s and
Magnetic Media screen.

The Payer Address Lines and Recipient Address Lines print in all uppercase letters.

Costpoint totals each 1099-MISC type for the selected calendar year and places totals in the appropriate
box on the 1099-MISC form (when printed).
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The 1099-MISC report totals the 1099-MISC types by vendor.
The 1099-MISC types supported in Costpoint and their limits are summarized in the following table.

Number Code
Box 1 Rents $600 or more RENT
Box 2 Royalties $10 or more ROYAL
Box 3 Other Income $600 or more OTHER
Box 4 Federal Income Tax Withheld All amounts FED
Box 5 Fishing Boat Proceeds All amounts FISH
Box 6 Medical and health care payments $600 or more MED
Box 7 Non-employee compensation $600 or more NONEMP
Box 8 Substitute Payments in lieu of dividends or interest = $10 or more DIVD
Box 9* Payer made direct sales of 5000 or more of $5000 or more SALE
consumer products to a buyer (recipient)
Box 10 Crop Insurance proceeds $600 or more CROP
Box 14 Gross proceeds paid to an attorney $600 or more GATT

* If amounts recorded exceed 4,999.99, Costpoint prints an X in the box.

1099s Section of Manage Vendors

To maintain 1099 information:

1.

2.

In the Vendor 1099 Name field, enter the Vendor’'s Tax ID name, if it is different from the Sole
Proprietor, in the Long Name field on the Manage Vendors screen.

1099's

Print 1099-MISC Form

Type (NONEMP v

Tax ID 52-0223375

o 1099 NON EMPLOYEE
Name

Select the Print 1099-MISC Form check box to track, create, and print 1099-MISC information
for this vendor. If you do not select this check box, a 1099 will not print for this vendor.

Selecting this check box affects the creation and printing of 1099s for this vendor and serves as a
default for the 1099 column and 1099-MISC Type column on the voucher line on the Manage A/P
Vouchers and Manage PO Vouchers screen.
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3. Select the type of 1099 payments made to this vendor. This selection determines the type of
1099-MISC income that is the default for this vendor. The Type drop-down list includes some

1099 types that do not print on the 1099-MISC form:

= A: Acquisition/Abandonment

= B: Broker and Barter

= DIV: Dividends and Proceeds

= G: Certain Government Payments

= INT: Interest Income

=  OID: Original Issue Discount

= PATR: Taxable Distribution from Coop
= R: Retirement Distributions

You can flag the line with any of the 1099 types listed, but Costpoint does not support these 1099
types on a printed form.

Accounts Payable: Manage Accounts Payable Vouchers

# W [ Browse Applications > Accounting > Accounts Payable > Voucher Processing > Manage Accounts Payable Vouchers 1A th O
Manage Accounts Payable Vouchers New || Copy | v || Detete || Attach || Approval |_”_\ 101 1 Existng |_”_H_\ Table W m|—|o[x]
Identification Currencies

Voucher 823 (Pt e 2039 | Peried” 12)  Subperiod® 1] Trans  USD Pay  USD
Vendor™ 1099NON ) 1028 NON EMPLOYEE Terms NET 10 ] (JApproved (] Template Line Default

Header Info Details Address | Check Recur Subcontractor Info Notes/Doc Loc = Entry Defaults

Invoice

Due

Number Date 12/05/2039 Amount * 15,000.00 Date 12/15/2039 m|
Discount Amount 15,000.00
Percent 0.00% Date 12/05/2039 ™~ Amount 0.00
Account Descriptions. Voucher Type
AlP AP 02000.1 ) Cash CASH 01000-010 2 ] AP Voucher
Original Voucher
Voucher Line Distribution Recalculation Method [Recalculate Cost - Recalculate
When Calculated Sales Tax is Changed |Recalculate Tot Before Disc v Recalculate
Total Tax 0.00 Remaining Balance 0.00
Exchange Rates Voucher Totals
ArP Voucher Detail New || Copy | ¥ || Delete || Approval || Form || uery [ » || —
- Organization _ Project _Proj Acct Abbrev  Cost Amount  Percent Taxability  Tax/VAT Code Tax Rate Sales/VAT Tax Amt Tot Before Disc | Discount  Total Amt  Use/Reverse Tax Amt Recovery Rate Recovery Amt Vendor 1099's 1099 Type Description Org Abbre
11 15,000.00{ 100.00%|U VA 13.0000% 0.00 15,000.00 0.00 15,000.00| 1,950.00 100.00% 1.950.00 NONEMP Joan Non Proj
4 >

Vendor Labor Currency Line Customs Info

After the vendor has 1099 information in the 1099s section, the voucher lines for the vendor default to
selected in the 1099 column and the default 1099 type displays in the Type column.

Clear the 1099 column if that particular voucher line is not a 1099 reportable amount.

When you pay the voucher, Costpoint uses the lines designated as 1099 reportable in calculating the
1099 payments for this vendor.

Costpoint uses the check date when calculating 1099 amounts, which are based on the calendar year
(January 1 through December 31). If you posted a 1099 amount for a vendor in December 2021, but paid
the vendor in January 2022 (and the check is dated 2022), the 1099 amount is reported in the calendar
year 2022.
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Accounts Payable Utilities: Manage Vendor History

4 m Browse Applications > Accounfing > Accounis Payable = Accounis Payable Ulilities = Manage Vendor History

Maintain Vendor History Mew | Copy W | Delete 1 of 1 Existing Table |Query W[ ] ™ (]| X
Identification Currencies

Voucher No 24144 Fiscal Year* 2039 ) Period* 1 Subperiod * 1 Trans  USD Pay USD

Vendor * 1099NON ) 1099 NON EMPLOYEE ) ) seano 2

LR EU Header Info  Address  Subcontractor Info Notes/Doc Loc Recalculate Lines

Invoice Discount Due
Number Percent 0.00% Date 091152039 P
Date 09/05/2039 Date 09/05/2039 Amount 15,000.00
Amount 15,000.00 Amount 0.00
Total Tax 0.00 Remaining Balance 0.00 AP Voucher
Exchange Rates  Voucher Totals
Voucher line Mew | Copy W | Delete | Form Quey W |[™
= 4 ) |
¥ | Taxabiity*  TaxCode Tax Rate | Sales/VAT Tax Amt Tot Before Disc | Discount  Total Amt  Use Tax Amt Recovery Rate Recovery Amt ] 1099 1099 Type | Org Abbrev  Proj Abbrev |
None | 0.00%)| 0.00| 15,000.00| 0.00] 15,000.00 0.00 0.00% 0.00] W] NONEMP  |sTI | |
4 - »

Default Lines I

Vendor Labor  Currency Line  Customs Info

Posted voucher information displays on the Manage Vendor History screen.

You can edit the 1099 check box and the 1099 Type column on this screen if you selected the Print
1099-MISC Form check box on the Manage Vendors screen.

You cannot edit voucher 1099 information on this screen if you have not set up the vendor to be a 1099
vendor on the Manage Vendor screen.

If you need to update the total 1099 amount for a vendor after making changes or corrections on this
screen, go to the Create 1099 Information screen and run it again for that vendor.

Costpoint calculates the 1099 amounts by calendar year, based on the check date (month, day, and year)
and the check amount.

1099-MISC Processing

Create 1099 Information

* Browse Applications > Accounting > Accounts Payable > Year-End Processing > Create 1099 Information
=) ldentification New Copy W | Delate 10f 1 New Table | Query W |[] | X
Parameter ID * Description *

Selection Ranges

Option Start End
Taxable Entity A . ) )
Pay Vendor * [ ) )
Options
Calendar Year ™ 2039 Q

The Create 1099 Information screen calculates 1099 information used to print 1099-MISC income
amounts. When you use this screen, the process creates 1099 information for all vendors designated as
1099 vendors, regardless of how much 1099 income has been paid to them.
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To create 1099 information, Costpoint must access check data for vouchers that contain 1099 amounts.
Before you create and print 1099s for these vendors, you must record the checks against the vouchers
and post the checks.

Costpoint uses the following process to calculate 1099 income:

= Vendor Check History Table: Identifies all pay vendors in the range that had payments in the
current year. Eliminates non-1099 vendors. Identifies which checks were paid to these pay
vendors in current and prior years, then totals the amounts of these checks by voucher.

= Voucher Line Account History: Costpoint totals the 1099 amount of each voucher by 1099
Type.

= Cash Organizations: After the voucher line 1099 amounts are totaled, the process identifies the
cash organizations from which the 1099 vendors were paid and uses these cash organizations to
map the pay vendors back to the proper Taxable Entity.

= Calculate 1099 Amount: The following examples illustrate 1099 amount calculations.

If you have more than one Taxable Entity set up, you must complete the following steps:
1. Map organizations to specific Taxable Entities via the Manage Organization Elements screen.

2. Enter information about your Taxable Entity on the Configure Company Information screen.

Example A
Description Amount
Voucher: 1099 Amount $ 100.00 (a)
Non-Taxable Amount 80.00
Total 180.00
Total Prior Year Payments $ 70.00 (b)
Total Current Year Payments 110.00
Total 180.00
Voucher: 1099 Amount $ 100.00 (a)
Total Prior Year Payments 70.00 (b)
Current Year 1099 Amount 30.00

Reportable 1099 amount = Total Current Year Payments or (1099 Income (a) - Total Prior Year Payments
(b))

Total Current Year Payments = $110.00

(1099 Income (a) - Total Prior Year Payments (b)) = ($100) - $70 = $30

Since $30 is less than $110, Costpoint uses $30 as the 1099 income. After prior year payments, only $30
of 1099 income remained to be paid off in the current year. The other portion of current year payments
was made on non-1099 amounts.
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Example B
Description Amount
Voucher: 1099 Amount $ 100.00 (a)
Non-Taxable Amount 80.00
Total 180.00
Total Prior Year Payments $ 20.00 (b)
Total Current Year Payments 60.00 (c)
Total 80.00
Voucher: 1099 Amount $ 100.00 (a)
Total Prior Year Payments 20.00 (b)
Current Year 1099 Amount 60.00 (c)
Remainder for future year 1099 20.00

Reportable 1099 Amount = Total Current Year Payments (c) or (1099 Amount (a) - Total Prior Year
Payments (b))

Total Current Year Payments (c) = $60
(1099 Amount (a) - Total Prior Year Payments (b)) = ($100 - $20) = $80

Since $60 is less than $80, Costpoint uses $60 as the 1099 Amount. While the voucher included $80 of
1099 income after prior year payments, the vendor only received $60 of that in the current year. The
vendor can only be taxed on 1099 income actually received in a calendar year.

Print 1099 Edit Report

* Browse Applications > Accounfing = Accounts Payable > Year-End Processing > Print 1099 Edit Report
=) ldentification New | Copy W | Dalate 1071 Hew Table | Query W |[]| 7| X
Parameter ID* Description *
Selection Ranges Sort By
Option Start End 1st Sort*
Taxable Entity (Al v ) ) |Taxable Entity v
Pay Vendor |All A l l
Calendar Year One 2039 Q
Options
Optional Page Break
Al Taxable Entity [] At Vendor

[] Include Vendors where payments are below the reportable amount

Use the 1099 Edit Report to review your 1099 information for discrepancies before printing 1099s. To run
this report, you must have already created 1099 Information using the Create 1099 Information screen.

This report prints the pay vendor’s ID, the vendor 1099 name and tax ID, the 1099 Type and amount, and
the taxable entity’s ID and tax ID. The address codes and addresses for vendors do not print on this
report.

Select the Include Vendors where payments are below the reportable amount check box to include
vendors with payment amounts below the reportable amount. Leave the check box cleared to exclude
them.
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= If you sort the report by Taxable Entity, the total amount of 1099 income prints as a subtotal for
each company. The total number of records for each Taxable Entity also prints on the report.

= |f you sort the report by pay vendor, a grand total of all 1099 income prints on the report as well
as the number of 1099 records.

Note: For the Range Option in the Select Pay Vendor group box, you can use the Lookup in the
From and To fields to select a Pay Vendor ID. Your choices are limited to those pay vendors flagged
for 1099 creation on the 1099 section of the Manage Vendors screen.

Tips for Printing the 1099 Edit Report

To save your sort options and selection criteria for this report (with or without printing):

1. Enter an alphanumeric identifying parameter ID and a short description for this set of print
parameters.

2. After making your selections, click the Save icon in the toolbar or click File » Save.

3. Click Close.

Later, you can use Find or Query from this screen to access the print parameters you created and run the
same report without having to enter all the information again.

Sample 1099 Edit Report

Year End Company

: Page 1 of 1

1099 Edit Report b

Calendar Year. 2039 03:17 PM

Pay Vendor Vendor 1099 Name Tax ID 1099 Type 1099 Amount
Taxable Entity: 1/ACME PRODUCTION
Tax ID: 313441341

1099NON 1099 NON EMPLOYEE 52-0223375 NONEMP 35,000.00

Total Amount for 1098NON: 35,000.00

Total 1099 Amount: 35,000.00

Total Number of Vendors: 1 Total Taxable Amount: 35,000.00

Edit 1099 Information

* Browse Applications > Accounling > Accounts Payable > Year-End Processing > Edit 1089 Information
Identification 1 of 1 Existing Table | Query W |[] — ([ X
Taxable Entity 1 ACME PRODUCTION
Calendar Year 2039 TaxID 313441341
Total 1099 Amount 35,000.00 Total Taxable Amount 35,000.00

Edit 1099 Information Detail New | Copy W | Delete | Form | Query W ||~

—] Pay Vendor

¥ | payVendor* Cash Organization*| | 1099 Type * Tax ID Address Code | Print Address Foreign Adc1099 Amount™ Notes Long Name

1099NON [T NONEMP  |52-0223375 BILLING [ ™ [p v] 3500000 [1099 NON EMPLOYEE 1099 NON EMPLOYEE

14 id
Check Detail

1099 Name
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Use the Edit 1099 Information screen to view, edit, and add 1099 income information for pay vendors, by
taxable entity. To use this screen, run Query or Find to select a taxable entity and calendar year.

You can edit the 1099 amount and address code or delete lines of information for existing vendors if you
have already run the Create 1099 Information screen. However, if you run the Create 1099 Information
screen again, you will lose any edits that you have made.

The difference between the Total 1099 Amount and the Total Taxable Amount is any payment that is
less than the Reportable Amount. The 1099 does not print any amounts that are below the reportable
amount. For example, if a 1099-MISC for NONEMP totals to $500.00, it does not print because it is less
than the limit of $600.00; it is included in the Total 1099 Amount but is not included in the Total Taxable
Amount.

Click the Check Detail button to display the Check Detail subtask (see page 133). Use the Check Detail
subtask to view payment data for each pay vendor to help you reconcile discrepancies in 1099 income.

After you use the Create 1099 Information application to create 1099s, you can use the Edit 1099
Information screen to add a 1099 line and/or delete an existing line.
To add a 1099 line:
1. Go to the word Line.
2. Click New Record or press CTRL+N.
3. Enter the required information on the line and save. After the line is saved, you cannot edit the
new line you just created, but you can delete it.
To delete an existing line:
1. Highlight an existing line.
2. Click the toolbar function LINE.
3. Click Delete Record.

If you make edits to this screen, you will lose them if you execute the Create 1099 Information application
again.

Check Detail Subtask of Edit 1099 Information

Identification > Check Detail

Total Paid Amount 70,650.00
Vendor Check Detail
= Check Number Check Date Paid Amount Voucher Number I;l
368 02/18/2039 5,000.00 24145 4
| 369 09/04/2039 15,000.00 24144 —

To display the Check Detail subtask, highlight a row on the Edit 1099 Information screen and click the
Check Detail button.

Use this subtask to view data for each pay vendor. The information displayed on this subtask comes from
the Vendor Check History, Vendor Check History Voucher Detail, and Voucher Header History tables. All
fields on this screen are non-editable.
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If you are using this subtask from a new line, you must enter the pay vendor and cash organization before
Costpoint can access any information.

The Check Detail subtask's Total Paid Amount field reflects checks that have been issued to this
vendor; however, it does not reflect any checks that have been voided. Voided checks are not included in
the 1099 amount on the main screen.

1099 Magnetic Media Changes

= Changes made to record A, B, and C. See Publication 1220.

=  Allow NONEMP (1), FED (4), and SALES (reflected on the Copy B record with a 1 in column
547) types for NEC.

= Copy A change:

= Nothing visual. Columns added for Type H and J codes. Not used in Costpoint, so there will
always be spaces. Columns 44 and 45. See page 52.

= Copy B changes:

= Add new columns (247-270) for Type H and J amounts. Not used in Costpoint; always zero.
See page 77.

= Columns 271- 286 blank.
= Remaining columns start in 287. See page 78.
= Sales indicator is in column 547. See page 112 for MISC. See page 113 for NEC.
= Copy C changes:
=  Add new columns (304-399) for Type H and J amounts. Not used in Costpoint; always zero.
= Columns 340—499 blank

Print/Create 1099s and Magnetic Media

= Options | Print Format
= New NEC Copy to Print option

This is necessary as Copy A does not have enough room for two address lines for the Recipient. CP
currently prints two lines.

= Copy A: Only first address line prints

= Other Copies: Two address lines print
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ew | Gony | ¥ |[[petete | [19]75 ][ or 1 e ][5 7] [l |[ ey v |[m ][ 0] |
Parameter ID* Description *
Generate
(@ Print 1099s (O Create Magnetic Media Print Option  [-None- v

Selection Ranges

Calendar Year * 2021'

Option Start End 1099 Types to Include
Pay Vendor Name ™ (&]] v l l Non-Employee Compensation
Taxable Entity One ' All Other Types
Options
Print Format
Copy B Options
@® 1099-MISC Standard (0 1099-MISC Self-Mailer [7) Recipient ID Masking  Recipient ID Masking Character =
(O 1099-NEC (0 1099-NEC Self-Mailer
NEC Copy To Print
Copy A Cther Copies
Magnetic Media Information
Test Prior Year
Localon ' Override File
File Name

Contact Name
Phone Number/Ext
Email Address
Transmitter Info
TIN Control Code

Name

Use this screen to print 1099s or create a file of 1099-MISC and 1099-NEC information. See the table on
page 7 for a summary of the boxes, descriptions, limit amounts, and Costpoint codes.

Note: Costpoint supports the masking of the vendor Tax ID when printing. This should only be used
when printing the Copy B of the 1099.

You can create 1099 information for past or future years. Costpoint prints them using the current year’s
1099-MISC/NEC format.

You must print by Non-Employee Compensation or All Other Types, not both.

The Print 1099s program prints 1099-MISC/NEC information on pre-printed, official IRS forms for laser
printers. Self-Mailers are available if you select Laser as the printer.

Costpoint supports printing standard 1099-MISC/NEC forms and 1099-MISC/NEC Self-Mailers.

After printing 1099s, Costpoint displays the number of 1099s printed and the total amounts for each type
of 1099-MISC/NEC income. If you miss the message, print 1099s to a file, with the same parameters. At
the end of the run, note the final count and amount, and then delete the file.

Note: To ensure that your 1099 information is correct, print 1099s on blank paper before printing
them on the forms and before you create the file. After you create the file, you will not be able to
correct any errors without recreating the entire file.
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Create Magnetic Media

-3 Identification New || Copy | ¥ || Delete Table || Query | W ||l || (3| X
Parameter ID * Description *
Generate

(@) Print 1099s Create Magnetic Media Print Option  -None- v

Selection Ranges

Calendar Year* 2020|

Option Start End 1099 Types to Include
Pay Vendor Name™* (a] v ' I ®) Non-Employee Compensation
Taxable Entity One l _) All Other Types
Options
Print Format
Copy B Options
e) 1099-MISC Standard 1099-MISC Seli-Mailer

[] Recipient ID Masking Recipient ID Masking Character =

() 1099-NEC 1099-NEC Self-Mailer
Magnetic Media Information
Test Prior Year
Location l Override File
File Name

Contact Name
Phone Number/Ext
Email Address
Transmitter Info
TIN Control Code

Name

You can only create a file for electronic filing for one taxable entity at a time. You must use a separate file
name for each taxable entity or you will have to copy the file to a different directory before creating the
next electronic file. The electronic file must be printed by Non-Employee Compensation or All Other
Types, not both. As such, electronic file submissions for Non-Employee Compensation (1099-NEC) and
All Other Types (1099-MISC) will be submitted to the IRS separately.

Screen Contents

Magnetic Media Information Group Box

This group box contains data fields that hold information that you can include in the file to transmit
electronically. Select the Create Magnetic Media option to enable this group box.

= Prior Year: Select this check box if the year you specified in Calendar Year is a prior calendar
year filing. If you select this setting, a P is inserted in Field Position 6 of the T record. By default,
this check box is cleared and is enabled, if creating the file to send electronically.

= Test: Select this check box if you want to send a test file to the IRS. To show that the file is a test
file, Costpoint marks it with a test indicator T in the Field Position 28 of the T record. A test file is
sent to the IRS if this is your company’s first Tax Year (TY) to file 1099 information.

= File Name: Enter the alphanumeric name in this required field; for example: IRSTAX.
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Contact Name: Enter the name of the person to contact if the IRS/MCC encounters problems
with the file or transmission. This alphanumeric field is required. The name that you enter here is
inserted in Position 304-343 of the T record.

Phone Number/Ext: Enter the telephone number of the person to contact about electronic filings,
with area code and extension, in this numeric field. This field is required. You do not need to enter
hyphens. For example, you could enter 304.263.8700 extension 5234 as 30426387005234. The
phone number is inserted into Position 344-358 of the T record.

Email Address: Enter the email address of the person the IRS should contact if there are any
questions.

Transmitter Info Group Box

This group box contains IRS Transmitter information that will be included in the file.

TIN: Enter the transmitter’s nine-digit Tax Identification Number; this may be an EIN or SSN. If
you leave this field blank, the TIN for the Company ID selected on this screen will be used. This is
not a required field. This number is inserted into Position 7—15 of the T record.

Control Code: Enter the five-character alphanumeric Transmitter Control Code (TCC) assigned
by the IRS/MCC. You must obtain a TCC to file data within this program. This code is issued after
you file the application for Filing Information Returns Magnetically/Electronically (IRS FORM
4419). This is a required field.

Name: If the Transmitter Name is different from the Company Name, enter the Transmitter Name
here. If the Transmitter Name is the same as the Company Name, then you can leave this field
blank. The Transmitter Name is inserted as the Company Name in Position 30-69 in the T record.
This is not a required field.

Print Format Group Box

1099-MISC Standard: This setting is enabled for both laser and impact printers for printing of the
1099-MISC format.

1099-NEC Standard: This setting is enabled for both laser and impact printers for printing of the
1099-NEC format.

1099-MISC Self-Mailers: This selection is available for laser printers for printing of the 1099-
MISC format. See Chapter 2: Ordering Forms for instructions on how to order forms, including
Self-Mailers.

1099-NEC Self-Mailers: This selection is available for laser printers for printing of the 1099-NEC
format. See Chapter 2: Ordering Forms for instructions on how to order forms, including Self-
Mailers.

Selection Ranges

Calendar Year: Use the drop-down list to select the calendar year for which you are reporting to
the IRS.

Pay Vendor Name: Enter the range of pay vendors by specifying the range of vendor IDs.

Taxable Entity: Specify the taxable entity for which the 1099s will be printed/created. Please
contact Deltek Customer Care if you need to print 1099s for a prior calendar year.

1099 Types to Include: Specify if this is for Non-Employee Compensation or All Other Types.
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Sample 2021 IRS 1099 Form

See Appendix A for a sample of the 2021 IRS 1099 form and links to the IRS website.
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Chapter 4: Closing the Leave Year

Closing the Leave Year Checklist

Use the following checklist as you close the leave year.

1. Make sure that the Leave Period Schedule for the new year has been added for
all leave cycles.

2. Make sure that timesheets with dates equal to or less than the last leave period
date for the year have been entered and posted to labor. (Do NOT post
timesheets with dates after the last leave period end date.)

3. Make sure that Leave Accruals for the last leave period of the year have been
processed and posted to the General Ledger.

4. Print the current leave year’'s Leave Accrual Report (keep the header page)
and review for accuracy.

5. Use the Reconcile Leave Balances Utility to have Costpoint create a journal
entry that trues up leave liability.

6. Verify that Leave Year Ceilings established on the Manage Leave Codes
screen are accurate.

7. Verify that the Calendar Year-End (CYE) Regulatory Update is installed before
closing the leave year.

8. Close the leave year.
9. Print the new leave year’s Leave Accrual Report (keep the header page) and

review for accuracy.

Accessing the Leave Application

To access Leave, click People » Leave » Leave Processing.
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Before You Close the Leave Year

A % [B Browse Applications > People > Leave » Leave Controls > Manage Leave Codes 1t O
Identification New | oy [ v || Detete | [15][ ][ 1 or1 s [ ][ [ 1] e | il [ m | — 1 x
Leave Code * VACA0 Description * [Vacation |
Options
Leave Type* VAC ] Excess Leave Type
Payout Leave Code ) Basis for Leave Deferral Leave Based on Hours Worked

[ Include Negative Balances in Leave Year Carryover @ Hire Date Leave Modifier ]
[J Report Leave to Employee in Days ) Leave Hire Date
Hours in Leave Day T Days to Defer Leave Usage 0 () Base Hours Worked on Eligible Labor Locations

Eligible Labor Locations Leave Table Details

Identification > Leave Table Details New || Copy | ¥ || Detete || Form || query | v |5 || — || x
51 Months Compute Unit of Annual (C) One-Time (D) Period Balance ‘Year Balance Period Accrual Year Accrual
¥ of service* Method * Hours Block Grant Date Block Grant Date. Accrual Rate © Ceiling * Ceiling * Ceiling * Ceiling *
0| P-Leave Period | 0 [ 5.000000] 120,00 80.00 999,999.999,999,999 00| 999,999,999,999,999.00
60 P-Leave Period 0 7.000000, 168.00 160.00 999,999,999 999,999 00 999,999,999,999,999.00
120 P-Leave Period 0 10.000000 24000 200.00 999,999.999,999,999 00 999,999,999,999,999.00

Before you close the leave year:
1. Verify that Leave Year Ceilings on the Manage Leave Codes screen are accurate.

2. Decide if Costpoint should bring negative balances in the leave year forward into the new leave
year. If so, select the Include Negative Balances in Leave Year Carryover check box on the
Manage Leave Codes screen.

3. Verify that the Leave Period Schedule for the new leave year has been added for all leave cycles
on the Manage Leave Periods screen.

4. Verify that timesheets with dates equal to or less than the last leave period date for the current
leave year have been entered and posted to labor. Important Note: Do not post Timesheets
belonging to the next leave year.

5. Verify that leave accruals for the last leave period of the year have been processed and posted to
the General Ledger.

6. Print the Accrual Leave Report for the Current Year (keep header page) and review for accuracy.

Reconcile Leave Balances

A % [@ Browse Applications > People > Leave > Leave Ulilities » Reconcile Leave Balances 1 O
-5 identification new || Copy | v |[ Detete | {15 1ot e[ ][] vaie || auery [ v |[m ][ =] ]
Parameter 1D * Description *
Selection Ranges Journal Entry Accounting Period
Option Start Fiscal Year * 2039 ]
Leave Cycle one CYE | Leave Period End Date 12/31/2039 — 1)
B All Employees Subperiod * 1)

Processing Options

[*}include Terminated Employees

[ Include Liability from Past Leave Years

Employees

- Employee * Name

|

In Configure Leave Settings if Reconcile Leave Balances is set to Account:

Use the Reconcile Leave Balances to have the system true-up the general ledger leave accrual balances
to the leave history balances. Costpoint compares the accrued liability to the General Ledger’s balance
and creates a journal entry for the differences it finds. Costpoint does this by multiplying the current year’'s
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ending leave hours by the employee’s current hourly rate found on the Manage Employee Salary
Information screen.

In Configure Leave Settings if Reconcile Leave Balances is set to Employee:

Use the Reconcile Leave Balances to have the system true-up the Leave History balance to the current
accrued liability. Costpoint does this by multiplying the current year’s ending leave hours by the
employee’s current hourly rate found on the Manage Employee Salary Information screen.

It will then create a journal entry for the difference found between the calculation and balance in Leave
History.

For either reconciliation method, you can run this process multiple times throughout the leave year. Since
Costpoint reconciles based on the system date (date the process is run) and accounting period
associated with it, you should run this process before the end of the year.

Please print the report first and review for accuracy. If you agree with the results, please process the
reconciliation entry. If you disagree with the results, you may correct your leave liability manually.

Warning: Leave Reconciliation is based on the system date and the accounting period that date falls
within. If you are reconciling after a system date of 12/31, ensure that you have run the Update
General Ledger Beginning Balance utilty prior to running Reconcile Leave Balances.

Close Leave Year

% [T Browse Applications = People » Leave > Year-End Processing » Close Leave Year

=) Identification New | Copy W | Delete 1 0f 1 New Table | Query W |[]| | X
Parameter ID * Description *
Selection Ranges Options Adjustment Records
Leave Cycle™  |CYE Q| Year End [ Include Inactive Employees Fiscal Year ® 2039 '
Leave Period Data [] Base New Balances and Payout on New Leave Year Salary Period * q
iliati il ey *
Start Date End Date Leave Year [] Reconciliation done prior to closing the leave year Subperiod j
Current 12/16/2039 123172039 2039
New 01/01/2040 01/15/2040 2040 Report Sort * Employee Name v

To close the leave year:
1. Check the dates in the Leave Period Data group box.

= Make sure that the Current Start Date and Current End Date are for the last period of your
Current Leave Year.

= Make sure that the Next Start Date and Next End Date are for the first period in your New
Leave Year.

2. Select the Include Inactive Employees check box if you want employees marked as inactive to
appear on the report.

3. Select the Base beginning balances on new leave year hourly rate check box if you want the
beginning balances of your new leave year to be based on the hourly rate that corresponds with
your new leave year. If not selected, the system will use the hourly rate associated with your old
leave year for the beginning balance in your new leave year.

4. Select Reconciliation done prior to closing the leave year if reconciliation has been completed
before closing the leave year.
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a. If reconciliation has been done, Costpoint will use actual amount balances from the
employee leave table.

b. If reconciliation has not been done, Costpoint uses employee’s hourly rate to create the
G/L Adjustment.

5. Select the Fiscal Year, Period, and Subperiod to which leave balance adjustments (due to
excess over ceiling) will be posted when you run the Close Leave Year process.

When you execute the Close Leave Year screen, Costpoint:
= Recognizes the Leave Year ceilings.

= Generates the new leave balance for review prior to closing. The Close Leave Year Report shows
the leave to be lost.

= Updates the beginning balances on the Manage Leave Beginning Balances screen with a new
line for each Leave Type assigned to the employee.

= Closes the last Leave Cycle and opens the New Leave Cycle on the Leave Periods screen.

= If Reconciliation method is by Account: Creates and posts an entry to the General Ledger if
transfer balance in excess of year ceiling is set up in Manage Leave Types.

= If Reconciliation method is by Employee: Creates and posts an entry to the General Ledger if
an employee’s yearly balance exceeds the Year Ceiling.

Warning: If timesheets containing a timesheet date fall within a leave period associated with a future
leave year, and those timesheets contain used leaves, a record with the future leave year will be
created in the leave history tables. This will prevent the current leave year to be closed using the
Close Leave Year screen. Beginning balances would have to be updated manually for the new leave
year.

After You Close the Leave Year

* Browse Applications = People = Leave = Leave Processing = Print Leave Accrual Report

=) |dentification Mew | Copy W | Delete 101 Hew Table [Query W |[] ™ X
Parameter ID* Description *
Selection Ranges Sort By
Option Start End 15t Sort*
Effective Date One 01/01/2040 ' Home Organization v
2nd Sort*

Leave Year One 2040
Employee Name v

Leave Cycle One v CYE )
Leave Type (Al v )
Organization (Al v ) )
Options
Include Page Break
[] Part-Time Employees [] Temporary Employees [] Leave Lost [] Deferred Leave [] Page Break on Employee

After you close the leave year:

1. Print the Leave Accrual Report for the New Leave Year (keep header page) and review for
accuracy.

2. Compare the Prior Leave Year Accrual Report to the New Leave Year Accrual Report. The
difference should be Leave Lost due to the Leave Year Ceilings.
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3.

If the New Leave Year Beginning Balances do not equal the expected balances, make
corrections on the Manage Leave Beginning Balances screen.

Timing Considerations: Example

For this example, assume the following:

Payroll and Leave periods are bi-weekly.

The last period of the year is December 7 through December 20.
The first period of the new year is December 21 through January 3.
You enter timesheets weekly for the bi-weekly payroll cycle.

The last payroll of the year will include timesheets dated December 7 through December 13 and
December 14 through December 20.

The first payroll of the year will include timesheets dated December 21 through December 27 and
December 29 through January 3.

The fiscal year is January 1 through December 31.

How will costs be recognized for fiscal year accounting?

Payroll: For the pay period December 21 through January 3, payroll would normally be posted in
the new fiscal year. An estimated accrual may be done based on the accrued salary amount for
14 days. The total accrual will be divided by 14 to get an estimated daily figure and multiplied by 9
to receive the estimated December 21 through 31 accrual amount. A reversing journal entry will
be done in the General Ledger Module to record the estimated December 21 through 31 accrual
amount in the current fiscal year and the reversing journal entry in the next fiscal year will reduce
the payroll posting.

Labor Costs: If using Time & Expense (T&E), your Timesheet Schedule in the T&E database
must be adjusted so that December 28 through 31 is an individual cycle. Likewise, the period of
January 1 through January 5 must be recognized as an individual cycle. Nothing needs to be
done in Costpoint. When uploading timesheets from T&E, or when entering timesheets directly
into Costpoint, you need to enter the time for December 28 through 31 separately, using a
December 31 date. If you have salaried employees and auto-adjust timesheets, you need to
change the percentage for this input as well as prorating the total of 100% across both
timesheets.

Leave Accruals: Leave accruals must be computed for the full leave period December 21
through January 3 and should be posted to the new fiscal year in the General Ledger of 2022,
which also matches the leave year associated with that leave period. Create a journal entry to
move the portion that belongs to the 2021 fiscal year (December 21 through 31) and post it in
2021. Create another journal entry to remove the 2021 portion from the 2022 year and post it to
the 2022 fiscal year.

When dealing with used leave and leave years, keep the following points in mind:

1. The Timesheet Date determines the Leave Period to which the used leave will post.

2. The Leave Year associated with the Leave Period determines the leave year to which the
used leave will be posted.
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Warning: If timesheets containing a timesheet date fall within a leave period associated with
a future leave year, and those timesheets contain used leave, a record with the future leave
year will be created in the leave history tables. This will prevent the current leave year to be
closed using the Close Leave Year screen. Beginning balances will have to be updated
manually for the new leave year.
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Chapter 5: Payroll Processing
Closing the Payroll Year Checklist

Use the following checklist as you complete your year-end steps for payroll processing.

1. Make sure that the Pay Period Schedule for the new year has been added to all
Pay Cycles.
2. Print the Social Security and Medicare Reconciliation Report from Payroll » Tax

Reporting and verify that the correct amount of Social Security and Medicare
has been withheld and accrued.

3. Make any needed corrections on the last payroll of the year.

4. Process (enter) all paychecks to be dated December 31 or earlier and post to
the General Ledger.

5. Make any adjustments on the current paycheck for taxes owed from the results
of the Print Social Security and Medicare Reconciliation Report or other
transactions you know must be accounted for at this time.

6. Perform the steps for Closing the Payroll Year.

7. Verify that any Pay Types that should be reported in Box 11 (Non-qualified
Plans Distribution) have been linked in the Payroll Controls » Manage Pay Type
Taxability screen.

8. Verify that any Deductions that should be reported in Box 12 have been linked
with the correct Deduction Type in Payroll » Deductions » Manage Deductions
screen.

9. Verify that any Deductions which you want to report in Box 14 have been linked
in Payroll » Deductions » Manage Deductions/Federal tab.

10. Verify that appropriate Deductions are designated as Employer-Sponsored
Health Coverage by checking the box on the Manage Deductions screen.

11. Verify that the Retirement Plan Covered check box is selected on the

Employee Payroll Information » Manage Employee Taxes screen for each
employee who participates in a qualified pension plan.

Accessing Tax Reporting

To access Tax Reporting, click People » Payroll » Tax Reporting.
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Before You Close the Payroll Year

b 4 EI Browse Applications = People = Payroll = Tax Reporting = Print Soc Sec and Medicare Reconciliation Report

=3 Identification Mew | Copy W | Delete 10f 1 New Table Query ¥ [] 7| X
Parameter ID* Descripion *

Options
Report Type Medicare
Social Security

Select Report Options
Range Type Start End
Taxable Entity One ) 1st Sort* [Employee Name v
Check Dates Range ) )

Before you close the payroll year:

1. Print the Social Security and Medicare Reconciliation Report and verify that the correct amount of
Social Security and Medicare has been withheld and accrued.

2. Make any adjustment on the current paycheck for taxes owed from the results of the Print Social
Security and Medicare Reconciliation Report or other transactions you know that must be
accounted for at this time.

3. Enter (process) all paychecks to be dated December 31 or earlier and post to the General
Ledger.

4. Add the Pay Period Schedule for the new year to all Pay Cycles.

Check the Ceiling Method option on the Manage Deductions screen and make changes if
needed:

w ED Browse Applications > People > Payroll > Deductions > Manage Deductions

Deduction New | Copy W |Delete | | | o  50f8Exsting » | M| Tabke Query wi[]T (X

Deduction Code * A01KLN Short Desc™ A01KLN Description * 401K Loan

PECTE Federal

Deduction Type * LOANDC l Employee Deferred Comp. Loan l [] Employer-Sponsored Health Coverage
[ Deduction
Computation Method ~ FIXAMT | [ceiing Metmoa*  [One-Time 3| Pay Type )
Rate % 0.0000% Ceiling Amount 100.00 Worker's Comp l
Amount 50.00 Eligible for Arears Union Rate 0.000000
Modify Code l Arrears Deduction l Start Date F
Priority 1 Through Date )

[ Confribution

Computation Method NO DED

Base on Additional Deductions

Rate % 0.0000% Ceiling Amount 0.00 Start Date
Amount 0.00 HSA Deduction ) Through Date
Modity Code )

Payroll Tax Interface
Tax Type -None- v State )

Tax Service Code

State Local Contribution Mstching Additional Deductions for Contribution Calculation  AcctVend/Ref No

6. Use the One Time ceiling method for items such as 401(k) loans that span more than one payroll
year. The Close Payroll Year program calculates the unpaid balance of the deduction and
replaces the ceiling amount on the Manage Employee Deductions screen with the unpaid

Year-End Guide 26



Deltek

Chapter 5: Payroll Processing

balance. If necessary, add the One Time ceiling method to the Manage Deduction screen prior to
closing the payroll year.

Note: If necessary, you can re-open the last pay cycle in the Payroll Year to enter additional payroll
records as long as they do not affect One Time ceiling method deductions.

Close Payroll Year
% [T Browse Applications > People = Payroll = Year-End Processing > Close Payroll Year
=) ldentification New | Copy W | Delate 10f 1 New Table |Query W |[]| ™| X
Parameter ID* | Description *
Selection Ranges Sort By
Option Start 15t Sort*

|Employee ID v

Pay Cycle One )

Pay Cycle Data

Start Date End Date Payroll Year
Current

Next

You must use this screen to close the payroll year.

Verify that the Pay Cycle Data is correct for both the Current and Next Lines. Make sure that the Current
Payroll Year reads 2021 and the Next Payroll Year reads 2022.

= If you run this screen and receive a message saying No rows found that meet selection
criteria, it means that you have no deductions with a ceiling method of One Time. You must still
close the payroll year.

= If you do have deduction methods of One Time and employees who are actively using them, you
will receive a report listing the employee name, deduction code, current limit, total deduction, and
new limit. After you review the report for accuracy, you should close your Payroll Year.
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After You Close the Payroll Year

After you close the payroll year:

1. Insert a new line under Payroll » Federal Taxes » Manage Federal Taxes with the new Payroll
Year information. This will not be updated in the CYE Regulatory Update.

[D Browse Applications >

NOCRMOREAE

A * People > Payroll > Federal Taxes > Manage Federal Taxes

Identification

Payroll Year * 2022
Details
Social Security Adjusting Amounts Fixed Number of Exemptions.
Wage Limit* 147000.00) Exemption Amount * 4,400.00 Step 2 of W-4 is Checked * 0
e e 6.20% Nonresident Alien - Married * 3
P Additional Amount* 12.550.00
Employee Rate * 6.20% Single * 2
Supplemental Wages. (¥t o e 2
Medicare Supplemental Tax Rate .
(57800.600 and under) * 22.00%
Wage Limit* 999,999,999.99 Dependent Credit Amounts
Supplemental Tax Rate 37.00%
Employer Rate * 1.45% o 5 %
[ & { ) Qualifying Ghildren under 17* 2,000.00
Employee Rate * 5%
MEETEC S 149 401(K) Other Dependents * 500.00
Additional Tax Threshold * 200,000.00 Wage Limit* 305,000.00
Additional Tax Rate * 0.90% 7 5
et 20,500.00 W.4 Deductions Worksheet
FuTA Affordable Care Act Married * 25,900.00
Wage Limit* 7,000.00 Federal Poverty Level* 12,880.00 Single * 12,950.00
Employer Rate * 0.60% Safe Harbor Affordability Rate * 0.0961 Head of Household * 19,400.00
Credit Rate* 5.40%
FUTA Credit Reduction States
——

Lm0

New || Copy | ¥ || Delete \:H:\m:mmq:\ »|[p1] [ Tevie |[query [ v | m][—][x]

You should use the tax information below to process payroll for 2022. This is the most current

information available at this time (November 2021).

Social Security Limit $147,000
Medicare Limit (no ceiling) $9,999,999*
Medicare Additional Tax Threshold 200,000.00
Medicare Additional Tax Rate 0.90%
Federal Exemption Amount $4,400
401(k) Deferral Limit $20,500
401(k)Catch Up for Age 50 or over $6,500
401(k) Wage Limit $305,000
FUTA Limit $7,000"
FUTA Percent 0.6%"
Nonresident Alien Additional Amount $12,550*

* All wages subject to Medicare Tax
A 2022 amounts not known at time of printing

In Payroll » Deductions » Manage Deductions, update any deductions or contributions that

have had an increase/decrease for the next payroll year. You can use the Employee »
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Employee Payroll Information » Update Employee Deductions/Contributions screen to
update the changes before the first payroll of the new year for each employee.

2022 State tax information that Deltek receives on or before January 15, 2022 will be shipped with the
Costpoint Tax Table Update in the first quarter of 2022.

W-2 Processing

Before You Create W-2s

Before you create W-2s, complete the following steps:
1. Perform the steps for closing the Payroll year.

2. Verify that any Pay Types that should be reported in Box 11 (Non-qualified Plans Distribution) have
been linked on the Payroll Controls » Manage Pay Type Taxability screen.

3. Verify that any Deductions that should be reported in Box 12 have been linked with the correct
Deduction Type on the Payroll » Deductions » Manage Deductions screen.

4. Verify that any Deductions that should be reported in Box 14 have been linked on the Payroll »
Deductions » Manage Deductions » Federal tab (for informational purposes only; this is not
required).

5. Verify that appropriate Deductions are designated as Employer-Sponsored Health Coverage by
checking the box on the Manage Deductions screen.

6. Verify that the Retirement Plan Covered check box is selected on the Employee Payroll Setup »
Employee Taxes screen for each employee who patrticipates in a qualified pension plan.

Manage Local Taxes

% (3] Browse Applicalions > People > Payroll > Local Taxes > Manage Local Taxes
=% Manage Local Taxes MNew | Copy W | Delete 1af 1 Naw Table (Query W [] — || X

Locality *

Local Tax Setup
Disability Insurance Type Family Leave Insurance Type
Stale* ) Y ¥P Y ¥F
() State Plan () State Plan
Tax Paid By ®) Employee (O Private Plan () Private Plan
() Employer (@) Not Applicable (@) Not Applicable
Tax Type
o New York W-2 Reporting Ohio Tax Collection Agency
City / County /
School / PSD Code (O New Yark City DRITA
Yonker: )C.C.A
Character Code onkers CA
(®) Not Appiicable (@) Not Applicable
X Payroll Tax Interface

Withholding Account ] '

Accrual Account | ' +/ Include in Export Payroll Taxes

Expense Account ) ] Tax Service Code

Tax ID / Reference Numbers | Vendor Information

Local Tax Details New Farm -
= Effective Tax Supplemental State WIH Annual Exempt Amt Exempt Amt Exempt Amt Credit
| Date * Based On* Tax Rate ™ State Credit Limit*  One Time Annually Ceiling Limit* Married * Single ™ Other* Amount *
4 " >

= The Disability Insurance Type group box is available if you select State Disability Insurance
from the drop-down list for the Tax Type field.
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= The Family Leave Insurance Type group box is available if you select Family Leave Insurance
from the drop-down list for the Tax Type field.

State-specific notes are summarized in the following table.

State Field and Description

Indiana County/School/Political Subdivision Code

If you are creating State Magnetic Media (an electronic file) for Indiana, you must
enter County Codes in Local Taxes for Indiana County Taxes. Report County
Codes in the electronic file only. Do not report County Codes on the printed W-2.

Costpoint does not provide the Indiana County Codes. For a list of the codes, see:
http://www.IN.gov/dor/taxforms/pdfs/w-2book.pdf.

Pennsylvania County/School/Political Subdivision Code

Be sure to enter the correct Pennsylvania political subdivision code.

Ohio County/School/Political Subdivision Code

If you are creating W-2s for the state of Ohio, you must enter School District
Numbers in Local Taxes for Ohio School District Taxes. The four-digit Ohio School
District Codes are required for the printed W-2 and the electronic file.

New York New York W-2 Reporting group box
This group box is available when you set the State field to NY.

If the employee’s state is NY the amount in State wages, tips, etc. should equal
the federal wages in box 1, Wages, tips and other compensation. Part-year New
York State residents should be treated the same as full-time residents and the
employee will allocate the part of his or her federal wages that are attributable to
services performed in New York State when filing the New York State part-year
resident income tax return.

New York City

If the employee is a full-year resident of New York City, the amount in Local
wages, tips, etc. should be the same as the federal wages reported in Box 1. If the
employee is a part-year resident of New York City, then the amount reported in
Local wages, tips, etc. should be only the amount of federal wages for the period
the employee was a New York City resident.

Yonkers

If the employee is a full-year resident of Yonkers, the amount in Local wages, tips,
etc. should be the same as the federal wages reported in Box 1. If the employee
was a part-year resident of Yonkers, he or she should be treated the same as full-
time residents and the employee will allocate the part of their federal wages that are
attributable to services performed in New York State when they file their New York
State part-year resident income tax return.

New Jersey Costpoint has three tax types that are specific to New Jersey:
=  Supplemental Workforce Fund

= Unemployment/Health Care
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State Field and Description

= Workforce Development Partnership Fund

Verify that the correct Tax Type is selected for New Jersey local taxes.

Manage Deductions Screen

W [i Browse Applications > People > Payroll > Deductions > Manage Deductions
=3 Deduction New | Copy W | Delete 10f 1 New Table | Quey W |[] (X
Deduction Code * Short Desc * Description *

PEETE Federal

[Deoumaon Type * 'l I [|_| Employer-Sponsored Health Coverage ]
[] Deduction
Computation Method NO DED l Ceiling Method * No Ceiling Pay Type l
Rate % 0.0000% Ceiling Amount 0.00 Worker's Comp '
Amount 0.00 Eligible for Aears Union Rate 0.000000
Modify Code | Amears Deduction | Start Date
Priority 99 Through Date
[] Contribution

Computation Method NO DED

Base on Additional Deductions

Rate % 0.0000% Ceiling Amount 0.00 Start Date
Amount 0.00 HSA Deduction I Through Date
Meodify Code )

Payroll Tax Interface
Tax Type |-Mone- v State '

Tax Semvice Code

State Local Contribution Matching  Additional Deductions for Contribution Calculation  AcctiVend/Ref No

Verify that the correct Deduction Type is associated with each deduction code before creating W-2s. The
drop-down list for the Deduction Types option includes the following settings:

= Employee HSA Contr (Caf Plan): Employee HSA Contributions through a Cafeteria Plan. This is
a pre-tax deduction and will be reported in Box 12 with a Code W.

=  Employee HSA Contr (Non Caf Plan): Employee HSA Contribution not through a Cafeteria
Plan. This is the post-tax deduction; it will not be included in Box 12.

= Ul/HIth Care/Workforce Dev: This option is for employers who track the NJ Ul/HIth
Care/Workforce Dev through deductions and report them in Box 14. This Deduction Type must be
used if you will be reporting Ul/Health Care/Workforce Development information through Box 14
and have Costpoint add the NJ SUTA (Ul) dollar amount (from the Manage Employee Earnings
History records) to Box 14.

If the deduction code will be tracked under the employer-sponsored health plan, then be sure to select
this box before creating your W-2s.

Recompute Taxable Wages

Warning: The Recompute Taxable Wages utility recomputes taxable wages in the Employee
Earnings Table. This may cause a discrepancy in previously reported wages to government agencies.
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W [i] Browse Applications > People > Payroll > Payroll Utilities > Recompute Taxable Wages
=) Identification New | Copy W | Delete 1 of 1 New Table |Quey W |[]| ™| X

Parameter ID * Description *

Select Sort By

Range Type Start End

Taxable Entity One ) 1st Sort* TaxType v
Payroll Year One 2nd So*  (EmployeelD v
Employees * v ' '
Check Dales * .

Options
Apply Employee's
Recompute current taxability

Federal ... [] Update the Tax Service Group ID
Social Security
MedICare. ........ococovrvvocerrrerrerrees
FUTA Taxable and Accrual

State.. e
SUTA Taxable and Accrual............

oooooo

Possible reasons for using this screen include the following:
= A Deduction’s taxability was set incorrectly. Therefore, taxable wages are wrong.
= A Pay Type’s taxability was set incorrectly. Therefore, taxable wages are wrong.
= An Employee was set up with the wrong tax status.

Run this utility before creating W-2s.

The results of using this utility are as follows:

= Taxable wages will be recomputed in the Employee Earning table with the current tax status on
the Manage Employee Taxes screen. If an employee’s status has changed during the year, you
may use the date range and employee range logic to specify the appropriate parameters. In this
case, run the utility for one employee/date range at a time.

= If a check range is selected that contains records for prior quarters, a correction may need to be
made with the government agency.
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Create W-2 Table
W [0 GBrowse Applications > People > Payroll > Year-End Processing > Create W-2 Table
= Identification New Copy W | Delete 1071 New Tabie | Query W (]| X
Parameter ID* Description *
Selection Ranges
Option Start End
Taxable Entity One l
Payroll Year One
Employee All v l I [[] Non-Contiguous
Options Sort By
Box 14 Descriptions New Jersey Reporting
Line 1 NJ-SDI PP#
1515
ez UIHCWD * Box 14 Deduclions i
Employee ID
-Select- Py
Line 3 [Box 14 Deductions.

Recreate W2 7 - .
L) et s Box 14 Deductions with system adding Ul

Local Taxes

. . Employes Non-C Range:
Local Taxes with system adding Ul e s

Guidelines for Creating W-2 Tables
= Create W-2s by employee.

= Use the select range options in List Mode for non-contiguous selections.

= W-2s are created by Taxable Entity. The Taxable Entity is determined by the Taxable Entity field
in Employee Earnings.

= All taxable wage information is taken from the taxable wage data fields in Employee Earnings.

Example

Use this screen to identify the optional deductions that you want to report in Box 14. For example, you
can use this screen for health insurance. Suppose you have one provider with three options:

= Employee A = single
=  Employee B = family
= Employee C = single plus one dependent

On your deduction screen you have three separate deduction codes set up. You can link each deduction
to Box 14 on the Deduction screen. Here you would enter a description, such as HLTH. No matter which
health deduction the employee has, it will be reported on Box 14. You have three lines for this purpose.

New Jersey Reporting

Specify the NJ-SDI PP Number before creating your W-2s. The NJ-SDI PP Number prints on the W-2
only if the Local Taxes Disability Insurance Type field is set to Private Plan. (NJ does not want to see
the plan number if it is a State Plan). The NJ-SDI PP Number prints in Box 15 (State), under the
Employer's state ID number.

The settings in the drop-down list for the UI/HC/WD reporting option are specific to New Jersey (NJ):

= Box 14 Deductions: If this option is selected, Costpoint will not add the NJ SUTA dollar amount
to the total amount. Select this option if you want to use the current functionality for Box 14; only
amounts associated with a Deduction Code that has a Box 14 line designated on the Federal
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subtask of the Deduction will be created. The NJ SUTA (Ul) amount will not be added to the total
amount, even if the Deduction Type is set to Ul/HIth Care/ Workforce Dev.

= Box 14 Deductions with system adding Ul: Select this option if you want Costpoint to add the
NJ SUTA (Ul) amount to the Box 14 Deduction amount. Costpoint adds the NJ SUTA dollar
amount to the Deduction Code that has the Deduction Type set to Ul/HIth Care/Workforce Dev
and that has a Box 14 line designated in the Federal subtask. Costpoint retrieves the NJ SUTA
information directly from the Manage Employee Earnings History records.

= Local Taxes: Select this option if you track Health Care, Workforce Dev Fund, and Supplemental
Workforce Fund through Local Taxes. All three types will be summed together and reported in the
boxes where local taxes information should be on the W-2.

= Local Taxes with system adding Ul: Select this option if you want Costpoint to add the NJ
SUTA (Ul) dollar amount to the sum of the three Tax Types:

=  Supplemental Workforce Fund
=  Unemployment/Health Care
= Workforce Development Partnership Fund

Costpoint retrieves the NJ SUTA information directly from the Manage Employee Earnings History
records. W-2s may be created as many times as necessary; however, any prior edits will be lost at
the time of creation.

Possible Error Message

No Records Found: There is no information in the Manage Employee Earnings History screen for the
pay cycle and/or payroll year you have entered on this screen.

Manage W-2s
* Browse Applications > People > Payroll > Year-End Processing > Manage W-2s
= ldentification New | Copy W | Delete 10f1 Hew Table | Query W |[]| ™| X
Payroll Year * | Employee* ' Taxable Entity * '
Details
[ Void

a 1 2

Wages, Tips, other Compensation Federal Income Tax Withheld
b 3 4

Social Security Wages Social Security Tax Withheld
[= 5 6

Medicare Wages & Tips Medicare Tax Withheld

7 8
Social Security Tips Allocated Tips
e 9 10
0.00 Dependent Care Benefits
1
Nonqualified Plans

f 13 14
[ Statutory Employee

[ Retirement Plan
[ Third-party Sick Pay

Box12 State Local

After you create W-2s, this table contains the information from Employee Earnings that will be on the W-2.
You can view and edit the data here. If an employee has more than one withholding state, he or she will
receive multiple W-2s. All federal information will be reported on the first W-2, with additional W-2s for
each state or locality.
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The box numbers on this screen correspond to the box numbers on the W-2 forms.

You can edit W-2s. However, you should make any edits to taxable wages, withholdings, or Box 12 on
the Manage Employee Earnings History screen for easier reconciliation of quarterly reports and for audit
tracking requirements. If you choose to re-create W-2s, any edits made here will be lost.

Information Sources

The sources of the information on the screen are as follows:

=  Company information (boxes b—c) is taken from General Ledger» General Ledger Controls»
Configure Company Information.

= Employee information (box e) is taken from Basic Employee Information» Manage Employee
Information.

= Boxes 1 through 11 come directly from the Employee Earnings table.

= Box 12 is a combination from Employee Earnings, as well as Deduction Type on the Manage
Deductions screen.

=  State and Local information come from the Employee Earnings table.

= Tax Reporting information also comes from the Employee Earnings table. Thus, the total of the
W-2s should reconcile with the combination of the four quarters of tax filings by the company.

Manage W-2s: Box 12

Identification > Box 12

- Code * Amount *

gl Q|

Box 12 contains dollar amounts to be reported by IRS Codes. The proper reporting of these codes is
determined by the deduction type you selected in Payroll » Deductions » Manage Deductions.

If you reported non-taxable moving expenses as a pay type for an employee, you must complete the
following steps for Costpoint to report this as Code P in Box 12:

1. Set up a deduction in Payroll » Deductions » Manage Deductions and link it to the deduction
type of Non-Taxable Moving Expenses.

2. Add a Z record to Payroll History» Manage Employee Earnings History screen with a negative
to the pay type and a positive to the deduction.

If the employer made a contribution to a Medical Savings Account that needs to be reported as Code R in
Box 12, link this Deduction/Contribution Code to the deduction type of Employer Medical Savings
Account in Payroll » Deductions » Manage Deductions.
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Manage W-2s: State and Local

Box12  State Local

Identification > State New Form —|Olx
7 State Employer's State Wages, State Income
(Box 15) * State ID (Box 15) Tips, Etc. (Box 16) Tax (Box 17) Notes
Close |
Identification > Local New Farm —Olx
v Locality Local Wages, Local Income
Locality * Name (Box 20) Tips, Etc. (Box 18) Tax (Box 19) Notes
Close |

Taxable wages and withholdings for states and tax localities display on these screens.

State Disability Insurance for the employee’s portion displays in Boxes 18, 19, and 20 and should have
been processed as a local tax.

New This Year

The following USERRA codes have been added to the Edit W-2 Information/Box 12 Lookup field:

= D 19: USERRA 2020 make up elective deferrals to a section 401(k) cash or deferred
arrangement.

= E 19: USERRA 2020 make up elective deferrals to a section 403(b) salary reduction agreement.

= F 19: USERRA 2020 make up elective deferrals to a section 408(k)(6) salary reduction
agreement.

= G 19: USERRA 2020 make up elective deferrals and employer contributions (including
nonelective deferrals) to a section 457(b) deferred comp plan.

=  H 19: USERRA 2020 make up elective deferrals under a section 501(c)(18)(D) tax-exempt
organization plan.

= S 19: USERRA 2020 make up employee salary reduction contributions under a section 408(p)
SIMPLE.

= Y 19: USERRA 2020 make up deferrals under section 409A nonqualified deferred compensation
plan.

= AA 19: USERRA 2020 make up designated Roth contributions to a section 401(k) plan.

= BB 19: USERRA 2020 make up designated Roth contributions under a section 403(b) salary
reduction agreement.

= EE 19: USERRA 2020 make up designated Roth contributions under a section 457(b) plan.

Print W-2s

Printing W-2s on blank paper enables reconciliation with tax filings before you need to submit the W-2s to
employees and taxing agencies. Deltek recommends that you print W-2s on blank paper and reconcile
them before printing on forms.

Then, print a test run on the form you are using. Five records serve as a good guide to test the alignment.
You may have to try a different printer driver for the alignment to be acceptable.
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You can test alignment at any time after you receive the CYE Regulatory Update and before you need to
print W-2s on the official forms.

- Browse Applications = People = Payroll = Year-End Processing = Print W-2s

=) Identification Mew | Copy W | Deletz 10f 1 New Table | Query W |[]| | X
Parameter D * Description ™
Selection Ranges
Option Start End
Employee Name v Al v ' l [] Mon-Contiguous
Range
Taxable Entity * One l
Payroll Year*® One
Form Type * One -Select- v
Sort By Options
1st Sort 2nd Sort*
Starting Control Number 1
Employee Name None
Employee Name Non-Contiguous Ranges  Employee Non-Contis Ranges Social Securify Number Non-Contiguous Ranges  Postal Code Non-Contiguous Ranges

Withholding State Mon-Contiguous Ranges  Organization Non-Contiguous Ranges  Locator Code Non-Configuous Ranges  Mailing State Non-Contiguous Ranges  Locality Non-Configuous Ranges

To print W-2s:

1.
2.

10.

Enter the required fields of data, designated with a red asterisk.

Select the Non-Contiguous Range check box to allow the various subtasks at the bottom of the
screen to become available for use.

Use the Starting Control No option to enter a starting control number for W-2s.
Print W-2s on blank paper and review them carefully before printing them on forms.

= You can sort the W-2s by Employee Name, Social Security Number, Employee ID, Postal
Code, State, Home Org, or Locator Code.

= You can print the W-2s for a single state. When printing the state copies of the W-2s, select
the primary sort of State.

If you need to make any adjustments, follow the recommendations in the “Edit W-2s” section,
starting on page 34. Reprint the W-2s on blank paper as many times as needed.

Reconcile your quarterly reports with the W-2 Summary Report.

When finalized, print the W-2s on the forms and deliver to employees by January 31. If your firm
has a bulk mailing rate, you can print employee copies by postal code.

Maintain Employer copies of the W-2 forms.

Create the file for Federal filing (using the Create Federal W-2 File screen), if applicable, and file
electronically with the Federal Government by February 28.

Create the file for State filing (using the Create State W-2 File screen), if applicable, and file
electronically with the appropriate State Government agency. If you are printing W-2s for multiple
states, you can print the employer copies by state.
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Print W-2 Summary Report

% [1 Browse Applications > People > Payroll > Year-End Processing = Print W-2 Summary Report
=3 Identification Maw | Copy W | Delete 10f1 New Table [Query W ]| | X
Parameter ID* Description *
Selection Ranges Options
Option Start
Taxable Entity * One ) ) [ Include Voided W-2s
Payroll Year* One

Use this screen to print the W-2 Summary Report, which summarizes the amounts found on each box of
the W-2s for the entire company.

Sample W-2 Summary Report

Year End Company

Page 10f 2

W-2 Summary Report B

Payroll Year: 2039 0222 PM

Taxable Entity ID: ACME PRODUCTION

Box 1 Federal Taxable Wages 220,685.03
Box 2 Federal Income Tax Withheld 50,303.01
Box 3 - Social Security Wages 150,636.56
Box 4 - Social Security Tax Withneld 27847
Bax 5 - Medicare Wages 225,186.56
Box & - Medicare Tax Withheld B0.81
Box 7 - Social Security Tips 0.00
Box 8 - Allocated Tips 0.00
Box 9 - Advance EIC Payment nia
Box 10 - Dependent Care Benefit 50,00
Baox 11 - Nonqualified Flans 0.00
Box 12 - Code A 0.00
Box 12 - Code B 0.00
Box 12 - Code C 136.59
Box 12 -Code D 135153
Box 12 - Code E 0.00
Box12- Code F 0.00
Box 12 -Code G 0.00
Box 12 - Code H 0.00
Bax 12 - Code J 0.00
Box 12 - Code K 0.00
Baox 12 - Code L 0.00
Bax 12 - Code M 0.00
Box 12 - Code N 0.00
Box 12 - Code P 0.00
Box 12 - Code Q 0.00
Box 12 -Code R 0.00
Box 12 - Code 5 0.00
Box 12 - Code T 0.00
Box 12 - Code V 0.00

Year-End Guide 38



Chapter 5: Payroll Processing

Deltek

Box 12 - Code W
Box 12-Code Y
Box 12-Code Z
Box 12 - Code AA
Box 12 - Code BB
Box 12 - Code CC
Box 12 - Code DD
Box 12 - Code EE
Box 12 - Code FF
Box 14 -Line 1
Box 14 - Line 2
Box 14 - Line 3

Year End Company

W-2 Summary Report

Baox 15 - State
Box 16 - State Wages
Box 17 - State Withholding

Box 15 - State
Box 16 - State Wages
Box 17 - State Withhokding

Bax 15 - State
Box 16 - State Wages
Box 17 - State Withholding

Box 20 - Locality
Box 18 - Locality Wages
Box 19 - Locality Withholding

Box 20 - Locality
Box 18 - Locality Wages
Bax 18 - Locality Withholding

Bax 20 - Locality
Box 18 - Locality Wages
Baox 19 - Locality Withhoiding

Bax 20 - Locality
Box 18 - Locality Wages
Bax 19 - Locality Withholding

Payrol Year 2039

Taxable Entity ID: ACME PRODUCTION

0.00
0.00
0.00
0.00
0.00
0.00
326.94
0.00
0.00
0.00
0.00
0.00

Page 20f2
12/31739
0Z22 PM

ChA
1,000.00
0.00

MD
1,11483
0.00

NJ
202,120.20
14,032.21

Mew Jersey Disability Ins
37020
0.00

NJSDI
31,270.20
11257

NJ Uemployement Local Tax
370.20
1.42

NJ Workforce Dev
201,750.00
0.74
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Manage Tax File Data
% [0 Browse Applications > People > Payroll = Year-End Processing > Manage Tax File Data
=3 Identification New Copy ¥  Delele 10f 1 New Table | Query ¥ [] | X
Taxable Entity Code * | qQ )
Preparer Code * [-Select- v
Kind of Employer * [Mone Apply v
Contact Information
Contact Name * Fax
Job Title E-mail *
Phone Number * Extension
Idaho
[] Fed/State Combined 1099 Participant Filing Cycle [-None- v Total 10995

You must set up the Manage Tax File Data screen in Payroll » Year End Processing for each taxable
entity in order to create the W-2 file to be transmitted electronically.

Create Federal W-2 File

The 2021 Calendar Year-End (CYE) Regulatory Update reflects the federal filing requirements as of
November 2021. Any future requirements will be incorporated in the Costpoint software and released in
early January 2022.

Use this screen to create the Federal file for electronic filing after your W-2s are finalized.

% [0 Browse Applications > People = Payroll > Year-End Processing > Create Federal W-2 File

=) Identification New | Copy ¥ | Delete 10 1 New Table | Query ¥ []— X
Parameter ID * Description *

Selection Ranges Sort By

Option 1st Sort

Taxable Entity * One l Employee Name
Payroll Year* One

Options
File Name [] Overwrite File
File Location )

File Data
Farmer EIN
UserID*
WFID Resub

[J Terminating Business

This screen creates the data file W2REPORT.YY where YY represents the payroll year for which the
report is created. You need to rename this data file to the IRS required file name W2REPORT (no
extension).

The Federal W-2 File Report prints automatically each time that you create the W2REPORT.YY file. After
running this program and reviewing the printed report, copy the file exactly as named above (W2REPORT
with no file extension). This is the file that you must send to the Social Security Administration.

Make sure that the file location you select is in a directory to which you have been granted rights. If you
receive an error message such as “file not found,” the file might have been created in a directory to which
you do not have access.
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Create State W-2 File

The 2021 CYE Regulatory Update reflects the state filing requirements as of November 2021. Some
states do not publish their filing changes until mid-November. Any future requirements will be
incorporated in the Costpoint software and released in early January 2022.

* Browse Applications > People > Payroll > Year-End Processing > Create State W-2 File

=3 Identification New  Copy ¥ | Delete 16 1 New Table | Query ¥ |[] — X
Parameter ID * | Description *

Selection Ranges

Option

Taxable Entity * One '

State® One )

Payroll Year* One

Options Sort By
Output File 1st Sort
File Name serwi il
[] Overwrite File Employee Name
File Location )
File Data
RV Record Data

Farmer EIN
Submission Date ol Late Filing Penalty

User ID*
Withholding Paid Interest Due

/

WFID Resub Other Amount Overpayment Handling Method * Apply as Credit

NJ UVHCAWD * Not applicable
Credit Amount MAICS Code

Computer Manufacturer
Balance Due Penalty IA Business eFile Number (BEN}

[] Terminating Business

Third Party Payer FEIN Third Party Payer Amount
Third Party Payer Name /| Complete Filing

The Create State W-2 Files screen creates a data file which you may file electronically.

Some states require the state ID to be in a certain format. Please review the manner in which you have
entered the state taxing ID in State Taxes to be sure that you will comply.

The State W-2 File Report prints automatically each time that you create the W2RPTST.YY file, where ST
represents the two-character state abbreviation code, and YY represents the payroll year for which you
are reporting in this screen. You must rename this data file to the file name required by the state, such as
W2REPORT (no extension). The information included in the file is identical to the printed W-2s.

Puerto Rico

The RS record file layout for Puerto Rico is not supported on the Create State Mag Media screen.

Common Roadblocks/Reconciliation Issues

Dollar amounts on the Earnings Report (or Tax Report) are not
balancing with W-2s.

An edit has been made to the Edit W-2 table and has not been recognized on the Manage Employee
Earnings History screen. Employee Earnings is the source for W-2s and Tax Reporting. Make any
adjustments on the Manage Employee Earnings History screen and re-create W-2s.
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[ have adjustments that [ have to make for such things as Relocation
Expenses (non-cash fringe), but I won't get the information until the 24
week of January.

You can still create your W-2s and print them to do your reconciliation with your taxes for the information
you currently have. Once that is reconciled, you should be able to identify any adjustments made (Z
records) and not have to start the whole reconciliation process over.

What can I do if I have under- or over-withheld an employee’s Social
Security, Medicare, or withholding and I have already started the
payroll for the next year?

Run the Print Soc Sec and Medicare Reconciliation Report after each payroll. This report identifies any
mistakes in taxable wages and withholdings during the year and allows your quarterly reports to be
correct during the year, thus avoiding amended returns.

If an employee is under-withheld, take one of the following actions:

= Make an agreement with the employee that you will adjust the record (Z record) and have the
employee pay you the dollar amount back as a “loan” in his or her next paycheck. Z records give
you an audit trail that a manual adjustment was done in a given year.

=  Adjust the withholding by taking out of federal and putting in Social Security/Medicare. Deltek
does not recommend this approach.

= Have your company pay the taxes for the employee as a “gross-up” benefit.

If an employee is over-withheld, reimburse the employee with a negative “loan” deduction.

Troubleshooting Tips

Taxable wages on W-2 are incorrect for an employee.

Print the Employee Earnings Report YTD for the employee and review it to see why taxable wages are
incorrect and what type of adjustment you need to make. Also, determine if the adjustment involves a
journal entry to be made to the General Ledger to recognize expense. In addition, if you do an adjustment
record with a check date prior to the fourth quarter, you must re-file your quarterly reports.

The Retirement Plan Covered check box is cleared on W-2 and needs to
be selected.

The Retirement Plan Covered check box was not selected in Employee Payroll Information» Manage
Employee Taxes. You should select that check box and re-create W-2s or select the check box on the
Edit W-2 screen.

['ve done my last payroll of the year, ran my Reconciliation Soc. Sec.
and Medicare Report, and found an employee who owes taxes. My
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employer decides he will pay the taxes for the employee. (The tax the
employer pays now becomes taxable wages to the employee.)

Enter a Z record on the Manage Employee Earnings History screen, with a check date of December 31,
check number of 999999, the dollar amount, and the Social Security and Medicare amounts to withhold,
resulting in a net 0.00 check.

Example
An employee owes $17.20 for Social Security and $3.40 for Medicare.
=  Gross up Calculation: 100 - 7.65 = 92.35% (6.2% S.S. and 1.45% Med.)
= $20.60/92.35% = $22.30 (Gross pay amount)
=  $17.20 + $1.38 = $ 18.58 (Social Security)*
= $ 3.40+%$0.32=% 3.72 (Medicare)**
= NetPaynow = 0.00
*$22.30 x6.2% = $1.38
**$22.30 x 1.45% = 0.32

You can use this calculation for “grossing-up” any amounts an employer may be paying for an employee.
The tax percentage to subtract from 100 will always be equal to the percentage of taxes to be withheld.
You must make a manual journal entry to recognize these transactions.

The same scenario as above occurs, however the employer does not
want to pay the taxes. (Deltek does not recommend this solution.)

= If the payroll year is closed, add a Z record to Manage Employee Earnings History screen that
moves the amount out of federal withholding and places the amount in Social Security and
Medicare withholding. You must make a manual journal entry to recognize this transaction.

= If the payroll year is open, add an X or Y record to Manage Payroll Records that removes the
amount from federal withholding and places the amount in Social Security and Medicare
withholding. Enter the check humber and a date before December 31 and then post the payroll
journal.

Any changes made in employee earnings that affect General Ledger also require a journal entry in the
General Ledger module, if you are not posting an X or Y record.

A deduction for an employee is not showing up in Box 12.

Select the deduction in Payroll » Deductions » Manage Deductions and link it to the correct Deduction
Type and re-create the W-2.

W-2 information is not aligning correctly on the form.

See the Costpoint online help system for printing hints and to verify that your printer set up is correctly. If
not, contact Costpoint Technical Customer Care.

Year-End Guide 43



Deltek

Chapter 5: Payroll Processing

W-2 Format

m Name Description

a. Employee's Social Security Number For security reasons, the Social Security number has
been moved out of the area that is visible when a
window envelope is used to mail the W-2s.

b. Employer Federal ID Number This field defaults from the Configure Company
Information screen in General Ledger.

C. Employer's Name, Address, and Zip  These fields default from the Configure Company

Code Information screen in General Ledger.
d. Control Number This box identifies the individual Form W-2.
e. | Employee's Name These fields default from the Manage Employee

Information screen.

f. Employee's Address and ZIP Code These fields default from the Manage Employee
Information screen.

1. Wages, Tips, and Other The amount displayed here is the sum of all Federal
Compensation Taxable amounts from the Manage Employee Earnings
History screen. All deferred compensation amounts
(Codes D-H in Box 12) and other Federal exempt pay
types and/or deductions are subtracted from gross
wages to arrive at this amount. Employer contributions
to 401(k) are not part of the calculation.

2. Federal Income Tax Withheld The amount displayed here is the sum of all Federal
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.

3. | Social Security Wages The amount displayed here is the sum of all Social
Security Taxable amounts from the Manage Employee
Earnings History screen. All Social Security exempt pay
types and/or deductions are subtracted from gross
wages to arrive at this amount.

4. Social Security Tax Withheld The amount displayed here is the sum of all Social
Security Withheld amounts from the Taxes Withheld
subtask of the Manage Employee Earnings History
screen.

5. Medicare Wages and Tips The amount displayed here is the sum of all Medicare
Taxable amounts from the Manage Employee Earnings
History screen.

6. Medicare Tax Withheld The amount displayed here is the sum of all Medicare
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.
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m Name Description

7. Social Security Tips You must enter an amount here, if applicable.

8.  Allocated Tips You must enter an amount here, if applicable. This
amount is not included in boxes 1, 3, 5, or 7.

9. This box is no longer printed on the W-2, since the
Advance EIC payment was eliminated for tax years
beginning after December 31, 2010.

10. Dependent Care Benefits The amount displayed here is the total amount of
withholding, from the Deductions subtask of the Manage
Employee Earnings History screen, for the deduction
code that you identified as a Dependent Care deduction
on the Manage Deductions screen.

11.  Nonqualified Plans The amount displayed here is the total amount, from the
Pay Types subtask of the Manage Employee Earnings
History screen, for the pay type that you associated with
this box on the Manage Pay Type Taxability screen.
This amount is:

= Reported in box 1, if it is a distribution made to the
employee from a nonqualified deferred
compensation or section 457 plan, or

* Included in box 3 and/or 5 if it is a prior year
deferral under a nonqualified or section 457 plan
that became taxable for Social Security and
Medicare taxes this year because there is no
longer a substantial risk of forfeiture of the
employee's right to the deferred amount.

12a— A Uncollected Social Security = The amount displayed here is the amount of uncollected
12d Tax on employee's tips Social Security or RRTA tax on tips.
B Uncollected Medicare Tax The amount displayed here is the amount of uncollected
on employee's tips Medicare tax on tips.
C Excess Life Insurance The amount displayed here is the cost of group-term life

insurance over $50,000 included in boxes 1, 3—up to
the Social Security wage base—and 5.

D Section 401(K) Deferred The amount displayed here is the amount of elective
Compensation Plan deferrals to section 401(k) cash or deferred

arrangement, and also includes deferrals under a
SIMPLE retirement account that is part of a section
401(k) arrangement. The amount shown here is the total
amount of withholding from the Deductions subtask of
the Manage Employee Earnings History screen, for the
deduction code that you identified as 401(k) Deferred
Compensation on the Manage Deductions screen.
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m Name Description

D USERRA (2009, 2011— USERRA (2009, 2011-2019) make up elective deferrals
09,11— 2019) make up elective to a section 401(k) cash or deferred arrangement.
19 deferrals to a section 401(k)
cash or deferred
arrangement.
E Section 403 (B) The amount displayed here is the total amount of
Salary Reduction withholding from the Deduction subtask of the Manage
Employee Earnings History screen, for the deduction
Agreement Deferred de that you identified as 403(b) Deferred
Compensation Plan c(::o e yo ;
ompensation on the Manage Deductions screen.
E 09, USERRA (2009, 2011- USERRA (2009, 2011-2019) make up elective deferrals
11-19  2019) make up elective to a section 403(b) salary reduction agreement.
deferrals to a section 403(b)
salary reduction agreement.
F Section 408(K) 6 The amount displayed here is the total amount of
Salary Reduction SEP withholding, from the I_Deductions subtask of the M_anage
Employee Earnings History screen, for the deduction
code that you identified as 408(k) 6 Deferred
Compensation on the Manage Deductions screen.
F 09, USERRA (2009, 2011— USERRA (2009, 2011-2019) make up elective deferrals
11-19  2019) make up elective to a section 408(k)(6) salary reduction agreement.
deferrals to a section
408(k)(6) salary reduction
agreement.
G Section 457(b) or 457(f) The amount displayed here is the total amount of
withholding from the Deductions subtask of the Manage
Employee Earnings History screen, for the deduction
code that you identified as 457 Deferred Compensation
in the Manage Deductions screen.
G 09, USERRA (2009, 2011- USERRA (2009, 2011-2019) make up elective
11-19  2019) make up elective deferrals and employer contributions (including
deferrals and employer nonelective deferrals) to a section 457(b) deferred
contributions (including compensation plan
nonelective deferrals) to a
section 457(b) deferred
compensation plan
H Section 501(C)18(D) The amount displayed here is the total amount of

Tax Exempt Organization
Plan

withholding, from the Deductions subtask of the Manage
Employee Earnings History screen, for the deduction
code that you identified as 501(c) 18(D) Deferred
Compensation on the Manage Deductions screen.
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m Name Description

H09, USERRA (2009, 2011- USERRA (2009, 2011-2019) make up elective deferrals
11-19  2019) make up elective under a section 501(c)(18)(D) tax-exempt organization
deferrals under a section plan.

501(c)(18)(D) tax-exempt
organization plan.

J Nontaxable Sick Pay The amount displayed here is the total amount of
nontaxable sick pay not included in boxes 1, 3, or 5.

K % Excise Tax on excess The amount displayed here is the total amount of
Golden Parachute withholding from the Deductions subtask of the Manage
Payments Employee Earnings History screen, for the deduction

code identified as Golden Parachute on the Manage
Deductions screen.

L Non-taxable Employee The amount displayed here is the total amount of non-
Business Expenses taxable Employee Business Expenses (if taxable
Employee Business Expenses are included in Box 1).

M Uncollected Social Security = The amount displayed here is the total amount of
Tax for Former Employees  uncollected Social Security or RRTA tax on cost of
group-term life insurance over $50,000 (former
employees only).

N Uncollected Medicare Tax The amount displayed here is the total amount of
for Former Employees uncollected Medicare tax on cost of group-term life
insurance over $50,000 (former employees only).

P Moving Expenses The amount displayed here is the total amount of
excludable moving expense reimbursements paid
directly to employee (not included in boxes 1, 3, or 5).

Q Non-taxable Combat Pay

R Employer Contributions The amount displayed here is the total amount of
employer contribution to the employee’s medical
savings account (MSA).

S Section 408(P) Plan The amount displayed here is the total amount of
employee salary reduction contributions under a section
408(p) SIMPLE (not included in box 1).

S USERRA (2009, 2011- USERRA (2009, 2011-2019) make up employee salary

09,11— 2019) make up employee reduction contributions under a section 408(p) SIMPLE.

19 salary reduction

contributions under a
section 408(p) SIMPLE.

T Adoption Benefits The amount displayed here is the total amount of
adoption benefits not included in box 1.
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m Name Description

\% Income for exercise of non-  The amount displayed here is the total amount of
statutory stock option(s) income from exercise of non-statutory stock option(s)
included in boxes 1, 3 (up to Social Security wage base)
or 5.

w Health Savings Account The amount displayed here is the total amount of
employer and employee contributions to a Health
Savings Account (HSA).

Y Section 409(A) Deferrals The amount displayed here is the total amount of
deferrals under a section 409A nonqualified deferred
compensation.

Y 09, USERRA (2009, 2011- USERRA (2009, 2011-2019) make up deferrals under

11-19  2019) make up deferrals section 409A nonqualified deferred compensation plan.

under section 409A
nonqualified deferred
compensation plan.

4 Section 409(A) Income The amount displayed here is the total amount of
income under a section 409A nonqualified deferred
compensation.

AA Roth 401(K) Contribution The amount displayed here is the total amount of

Plan designated Roth plan contributions under a section
401(k) plan.
AA 09, USERRA (2009, 2011— USERRA (2009, 2011-2019) make up elective deferrals

11-19  2019) make up designated to a section 401(k) cash or deferred arrangement.
Roth contributions to a
section 401(k) plan

BB Roth 401(B) Contribution The amount displayed here is the total amount of
Plan designated Roth plan contributions under a section
403(b) plan.
BB 09, USERRA (2009, 2011- USERRA (2009, 2011-2019) make up designated Roth
11-19  2019) make up designated  contributions under a section 403(b) salary reduction
Roth contributions under agreement.

section 403(b) salary
reduction agreement

CcC HIRE Exempt Wages and The amount of HIRE exempt wages and tips paid to

Tips qualified employees. Amount must be manually entered.
DD Cost of employer-sponsored = The amount displayed here is the cost of employer-
health coverage sponsored health coverage taken from the Deductions

and Contributions subtasks of the Manage Employee
Earnings History screen for Deductions/Contributions
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m Name Description

marked as Employer-Sponsored Health Coverage in the
Manage Deductions screen.

EE Designated Roth Designated Roth contributions under a governmental
contributions under a section 457(b) plan
governmental section
457(b) plan

USERRA (2011-2019) make up designated Roth

EE USERRA (2011-2019) contributions under a section 457(b) plan.

11-19 make up designated Roth
contributions under a
section 457(b) plan.

13 Retirement Plan Select this box if the employee was an “active
participant” (for any part of the year) in any of the
following.

= A qualified pension, profit-sharing, or stock-bonus
plan described in section 401(a) (including a 401(k)
plan).

= An annuity plan described in section 403(a).

= An annuity contract or custodial account described
in section 403(b).

= A simplified employee pension (SEP) plan
described in section 408(k).

= A SIMPLE retirement account described in section
408(p).

=  Atrust described in section 501(c)(18).

= A plan for federal, state, or local government
employees or by an agency or instrumentality
thereof (other than a section 457(b) plan).

14 Other

15 State This box displays the two-character abbreviation from
the Manage Employee Earnings History screen.
Employer's State ID No - The State ID Number as
entered on the State Taxes screen.

16 State Wages, Tips The amount displayed here is the sum of all State

Taxable amounts from the Manage Employee Earnings
History screen. All deferred compensation amounts
(Codes D-H in Box 12) and other State exempt pay
types and/or deductions are subtracted from Gross
Wages to arrive at this amount.
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m Name Description

17 State Income Tax The amount displayed here is the sum of all State
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.

18 Local Wages, Tips The amount displayed here is the sum of all Local
Taxable amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen. Any
SDI information also prints in this box, if setup as a
Local Tax.

19 Local Income Tax The amount displayed here is the sum of all Locality
Withheld amounts from the Taxes Withheld subtask of
the Manage Employee Earnings History screen.

20 Name of Locality This box displays the six-character codes from the
Taxes Withheld subtask of the Manage Employee
Earnings History screen.
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Configure General Ledger Settings

% [0 Browse Applications > Accounting > General Ledger = General Ledger Controls > Configure General Ledger Settings

Company Info
Company * 1 Name * Company 1
Options
& Validate Accounls for Organizations
] Post Labor Distribution te GL as Summary Entry

Retained Earnings Info

[/ Update Entry Info when editing a JE

[ Posting Validation for FY/Period/Subperiod

I Account 00312 ) FsLine Current Year Retained Earnings

Other Comprenensive income Info
OCI on the Income stalement @) Separate Statement of CI
Account 00311 I FS Line Income Taxes Payable
Data Entry Headings
Reference 1* REF1 Reference 2* REF2

Update G/L Beginning Balances Defaults

o Include Adjustment Pericds B4 Allow this defaull 1o be changed in Update process

O—|x

Non-Balancing JE's Password * ALLOW
No of Periods to Keep Open* 3
Functional Currency
S0 Code  USD U. S. Dollar
Print Journal For
M Labor ¥ Reference 1 ) Reference 2

Intsrcompany Receivables Posting Subperiod
¥ Use Maximum Open Subperiod

Balance Sheet Revaluation Options
] Creale Revalualion as Net

Corporate Settings ~ Approval Settings

The Configure General Ledger Settings screen determines the Retained Earnings account to which
Income and Expense accounts (determined by the Account Type designated on the Manage Accounts
screen) “close out.” If accounts are designated as Asset, Liability, or Stockholder’'s Equity, they will roll
forward their ending balances to become beginning balances in the new year.

Update General Ledger Beginning Balances

% [0 Browse Applications > Accounling > General Ledger > General Ledger Beginning Balances >

=3 ldentification
Parameter ID* Description *

Selection Ranges

Fiscal Year * 2039 ) Fiscal Year to be Updated 2040
Options
Print Options Show
[] Print Subiotals (® Changed Balances Only
[] Set Fiscal Year Status to Closed Closing Rate Type

Update General Ledger Beginning Balances

New | Copy ¥ | Delete Tof 1 New Table | Query ¥ [ X

Include Adjustment Periods

sort By
1st Sort*

(O All Balances (Account v

Use the Update General Ledger Beginning Balances screen:

= To roll forward ending balances of entered year and create beginning balances in the new year.

=  All accounts designated with an Account Type of Asset, Liability, or Stockholder’s Equity will
have beginning balances created in the new fiscal year by this process.

= To close the fiscal year.

The Fiscal Year status is changed to Closed only if you select the Set Fiscal Year Status to
Closed check box and set the Closing Rate Type option to Actual or Target.

You can only close the fiscal year if all accounting periods and subperiods in the fiscal year are
set to a Closed status (the Close Periods screen was used to close all accounting periods in the

fiscal year).

You can run this process multiple times, without closing the fiscal year.
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Manage Non-Project Beginning Balances

= Manage Non-Project Beginning Balances
Table | Query ¥ [] — || X

Accounting = General Ledger = General Ledger Beginning Balances

1 0f 1 Existing

% [0 Browse Applications =

Fiscal Year/Organization
Fiscal Year*® 2040 ) Organization* Y ) Y Organization )
Amount Hours
Running Balances 501,000.00 0.00
Account Details New | Copy ¥ Form | Query ¥~
v Account * Account Name Proj Required Beginning Amount Beginning Hours
‘00312 CURRENT YRRE N 6,000.00 0.00
‘ 00320 |PR\OR YR RETAINED EARNING ‘N ‘ 455000.00' 0.00|
i Currency Beginning Balances

If the Retained Earnings are separated into two accounts, one for current year and one for prior year,
then you must make a manual entry on the Manage Non-Project Beginning Balances screen for your new

fiscal year (2022).
To make the manual entry:
1. Add the Current Year Retained Earnings Beginning Amount to the Prior Year Retained Earnings

Beginning Amount.
2. Zero out the Current Year's Retained Earnings Beginning Amount.

After you complete these steps, your financial statement will appear correctly for the new fiscal year.
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Update Prior Year History

ﬁ\ * m Browse Applications > Projects = Cost and Revenue Processing > Cost and Revenue Processing Uilities > Update Prior Year History

Identification New || Copy | W || Dalete |:H:||-:HN-:W |:||:||:| Table || cuery | ¥ || W ||| %

Parameter ID* Description *

Selection Ranges

Option Start End
Fiscal Year One 2020 )
Projects (Al v l |
Dptions

Update
Project Ledger Labor History ] Units [ Biling Value [] Cobra History

Update Prior Year History Using

(®) Actual Burden Rates (") Target Burden Rates (O) Actual Burden Rates/Target Revenue
Adjustment Period Data to Include Retention of Project Setup Data

(®)Cost Only, No Revenue () Both Cost and Revenue ()No Adjustment Period Data Copy Project Setup Data to History Tables Clear Data From Project History Tables

Update Prior Year History creates prior year data for project reporting and revenue calculation. You must
run Update Prior Year History before computing revenue for the new fiscal year; otherwise, revenue may
not create and won’t appear correctly.

You can run Update Prior Year History multiple times. If at any time, you update or correct the prior year,
you must re-run Update Prior Year History after updating the PSR and creating your Project Report
Tables for the last period in the corrected year.
To complete the Update Prior Year History screen:
1. Enter the Fiscal Year for which you are closing.
2. Select the Update options for the data you wish to make prior year.
= Atthe least, select Project Ledger and Labor History.
= Select Units, if you currently load units for Revenue and/or Billing.
= Select Billing Value, if you currently use Goal Processing functionality.
= Select Cobra History, if you currently interface with the Cobra application.

3. Inthe Update Prior Year History Using group box, select the rates to be used when updating
the prior year history:

= Actual Burden Rates
= Target Burden Rates
= Actual Burden Rates/Target Revenue

4. Inthe Adjustment Period Data to Include group box, select the adjustment period data you
wish to roll to prior year:

a. Adjustment Period is designated on Accounting Period setup. This allows adjustments,
computations, and reporting outside “regular” financial periods.
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=  Cost Only, No Revenue: This allows any revenue calculated in the adjustment period to
remain in the closing year and then be recognized in a future period.

= Both Cost and Revenue: This assumes you have posted the revenue in the closing year and
need the revenue and cost to roll forward.

= No Adjustment Period Data

5. In the Retention of Project Setup Data group box, select the Retention option correct for your
company:

a. This function will copy project setup data to the history tables which allows you to
compute revenue in the prior year using the setup that existed at that time.

b. If history tables exist for a fiscal year, Costpoint will use that saved setup for revenue
computations and project reporting.

=  Copy Project Setup Data to History Tables: This process ONLY adds records if they do not
already exist.

= Clear Data From Project History Tables: This process deletes the existing data so that you
can recreate it.

= Overwrite Existing Records: This only allows the process to overwrite existing data with
updated data for the same record.

Copy Pools

Browse Applications = Projects = Cost and Revenue Processing > Cosi and Revenue Processing Utilities = Copy Pools

New |[ Copy [ W |[ Detete | [157][50 [ 1 of t new [ ][5 |[ 7] [ vabte |[ auen [ v |[ ][] X

Parameter ID * Description *

Selection Ranges
Routine to copy existing pools for new fiscal year.

This process may take a considerable amount of fime if a large amount of data exists.

Option Source Destination
Allocation Group™® e | 1Q
Fiscal Year * One 2020 2021 |
Pool * (Al v l l
Options
Data To Be Copied
Pool Base Data [] Cancel processing if destination Pool Rate Data fewer than source.
Pool Cost Data
Pool Rates Data
Service Center Data

Guidelines for the Copy Pools screen:
= Pools must be created every year prior to any billing, revenue, or reporting in the new year.
= Use the Copy Pools utility to copy pools from one year to the next.

= While Costpoint allows users to copy one pool at a time, it is suggested to copy all pools for the
new year at the same time.

= In the Source field, enter the allocation group and fiscal year from which the pools will be copied.

= In the Destination field, enter the allocation group and fiscal year to which the pool will be
copied.
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= Check the Cancel processing if destination Pool Rate fewer than source box to cancel the
process if the source fiscal year has more periods than the destination fiscal year.

Cost Pools

ﬁ\ w m Browse Applications = Projects = Cosi and Revenue Processing = Cost Pools = Manage Cost Pools

Identification New || Copy | W || Detete | | |4 || o || 3 of 7 Existing |_| AE™ E IF=RES
Allocation Group * {  Primary Allocation Group ) Fiscal Year® ogaq ) Sequence Number * 4
Pool Number * 1 PoolName*  Fringe Benefits Abbreviated Name *  Fringe
Pool Details  Default Accounts
Preferences
Pool Type  FRINGE l O Service Cenfer Apply Rates to Projects O Unallowable O Exclude Burden from Asset Inventory
Basis
. o Basis Type
Basis Description Total Labor (@ Dollars (O)Hours (OUnits
Debit Account 09801 l Credit Account 09802 l
Pool Cost Pool Base Service Center Pool Rates
Pool Rates New || Copy | ¥ || Delete || Form || Query | ¥ | # O x|
i Period * Pd Actual ¥TD Actual Pd Target YTD Target Pd Provisional ¥TD Provisional Pd Cost of Money YTD Cost of Money
2 0.000000% 0.000000%  30.000000% 35.000000% 30.000000% 30.000000% 4.000000% 4.500000%
1/ 0.000000%|  0.000000%| 30.000000%| 40.000000%| 30.000000% | 30.000000% | 3.000000% | 3.500000%

Before computing pools for the new fiscal year, use the Manage Cost Pools/Pool Rate subtask to
complete the following steps:

Zero out the Pd Act and YTD Act columns for all periods.

Enter/verify all other columns’ rates.

w nhn =

Add lines for all periods in fiscal year.
4. Make any changes to the pool’s cost and/or base setup.

Provisional rates are used for billing and Target rates can be used for project reporting and revenue
calculation. Actual rates are computed each period and can be used for project reporting and revenue
calculation.

Year-End Guide 55



Deltek

Chapter 7: ‘Closing’/Preparing the Projects Side

Build Rate Application Table

“ W m Browse Applications = Projects = Cost and Revenue Processing = Cost Pool Processing = Build Rate Application Table

Identification New || copy | W || Datets | [ 10| |10 1 mew | |[ 5 |[F1] [ Tavte |[ every [ w |[m [T ] X |
Parameter ID * [ Description *
Selection Ranges
Option Start
Allocation Group  One 1 Primary Allocation Group
Fiscal Year * One 2020 )
» Pools
Pools Query | ¥ | ||
. Sequence Number Pool Number Pool Description
1| 1|Fringe Benefits A
1 33 Ledd Fringe Pool
1 100 Fringe i
1 345 FRINGE
1 2223 Asian Fringe
1 8888 Brenda's Fringe Pool
1 9986 silver fringe
1 11111 Fringe
1 521789 Mela's Pool v

The Build Rate Application Table populates the table used to allocate indirect costs to projects. You must
run this process before calculating bills and computing burden in the new fiscal year. Always run this
application after:

= Creating/changing pools for the new fiscal year
= Changing pool base data

= Changing pool sequence numbers

Manage Burden Cost Ceilings

ﬁ\ * m Browse Applications = Projects = Project Setup = Project Ceilings = Manage Burden Cost Ceilings
- Identification New || Copy | W || Datete | [150][ 0 {[ 1 0f 1 mew | 0 |[ 5 |[ 1] | Tabte || cuey | ¥ || W ||| X% |
Project * ) ) Fiscal Year™ 2021 e}
d 0 gD
LJ Rate Cost of
Account™ Account Name Pool * Pool Name Rate Ceiling Format Ceil
4 " >

If your company uses Manage Burden Cost Ceilings, you must set them up every year because the
ceilings are maintained by project, based on the fiscal year of the pool.

Year-End Guide 56



Deltek

Chapter 7: ‘Closing’/Preparing the Projects Side

Manage Burden Fee Overrides

Applications > Projects > Project Setup > Project Ceilings > Manage Burden Fee Overrides

= Identification New | Copy ¥ | Delete ol 1 New Table | Query ¥ |[]|—|J| %

Project*

el

Burden Fee Override Details New

Apply to
rT Fiscal Year * Pool * Pool Name Fee Percent RIBIA ™

Enter, or use Lookup to select, the Project. ®I0% -

If your company uses the Manage Burden Fee Overrides screen, you must update it yearly because it is
maintained by project, based on the fiscal year of the pool.
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Complete the Costpoint Projects Year-End Processes

Update Prior Year History

Reference “Preparing/Closing the Project Side” in the Year-End Guide.

ﬁ\ * m Browse Applications > Projects = Cost and Revenue Processing > Cost and Revenue Processing Uilities > Update Prior Year History

Identification New || Copy | W || Dalete |_H_||-31|N-zw |_||_||_| Table || cuery | ¥ || W ||| %

Parameter ID* Description *

Selection Ranges

Option Start End
Fiscal Year One 2020 l
Projects (Al v l |
Dptions

Update
Project Ledger Labor History ] Units [ Biling Value [] Cobra History

Update Prior Year History Using

(®) Actual Burden Rates (") Target Burden Rates (O) Actual Burden Rates/Target Revenue
Adjustment Period Data to Include Retention of Project Setup Data

(®)Cost Only, No Revenue () Both Cost and Revenue ()No Adjustment Period Data Copy Project Setup Data to History Tables Clear Data From Project History Tables

1. If the prior year data does not exist in the PSR_PY_SUM table, NO ACTUALS will be included for
that year in reports.

= In Planning, there is a setting in Planning » Administration » Administration Controls »
Maintain Current Period.

= If the ‘Update Mode’ is set to Auto, the date on your computer will be used for the current
period and will change automatically.

= If the ‘Update Mode’ is set to Manual, the date will need to be changed manually in this
screen to make the new current period.

2. If the Update Prior Year History is incorrectly run so that future year or current year records (that
is, 2022+) now exist in PY_SUM, you will get a PY record in the B&P PSR with a negative value
backing out the amount of those records.

= To correct this, these records will have to be manually removed from Prior Year Cost and
Revenue in Costpoint. Query the records by fiscal year in the Manage Prior Cost and
Revenue screen and delete them.
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% [E Browse Applications > Projects > Project Setup > Project History = Manage Prior Vear Cost and Revenue Query (1) (S SNEE]
< Identification New | Copy ¥ | Delete o1 new Table | cuery w |O[=—[00[ %
Fiscal Year* 2019 ) Rate Type )
Project * | qQ )
Organization * ) )
Total Direct Allowed Amount Total Fees Total Revenue
Total Indirect Allowed Amount Total Adjustments to Revenue Award Fee Revenue
Details New Form -
et Amount Direct Amount iscount Biect et Directiours Ta Revenue Fooon Burden Amount | Burden Amoun]
. Account * Incurred Allowed Amount Fee Hours Allowed Allowed Hours Incurred Allowed
[ < 5]

Prior Year Pool Amounts

Enter, or use Lookup to select, a Project. ®100% -

=  When Update Prior Year Cost and Revenue has been cleared, set the Data Reset Flag in
Configuration Settings to Yes and run the Refresh (only needed for versions lower than 8.1).
This will replace current historical datawith incoming history from Costpoint.

= Note that when Planning rolls over years, there is a routine in Planning that recognizes it is in
a current period in a new fiscal year. It grabs data from the Prior Year tables in the Project
Domain and from PROJ-SUM for each project and puts it into temporary tables.

For example if your current period is Pd 1 2022, 2021 will be in the temporary Planning prior
year table. This happens if the fiscal year changes before the Project Year End Processes
are run.

= The Data Reset Flag does not need to be set back to NO as it auto resets to NO afterRefresh
has been run.

Applications > Planning > Administration > Administration Controls > Configuration Settings (MAM{0)
« Configuration Settings (MAN10) 0=Tx
Account _ Display _General Organization _ Project
Subperiod Method * [Separate Subperiods [ Include Adjustment Periods in Last Sub Period
Use Reorg Structure * (No v [] PSR Subperiod Display
Data Reset Flag* PSR Revenue Option Default
Number of Days to Retrieve Data * 1000
Days to Recalculate * C— 365
Vacation Types * VAC
®I00% -

Enter Data Reset Flag.
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Review Fiscal Year Setup for Closing Rate Type

Planning » Administration » Administration Controls » Fiscal Year
Setup

If you use Target rates throughout your Fiscal Year but close at Actual Rates, you need to update the
‘Closing Rate Type’ in Planning. See the breadcrumb trail above and go to column Closing Rate Type,
which can be Target or Actual. It will probably be ‘Target’ to agree to your financial rates throughout the
year, but needs to be changed to ‘Actual’ if that's how you close the financial year.

If you do not change the Planning Fiscal Year Setup » Closing Rate Code to agree to your financial
close rate type, you will likely see large ‘EAC Adjustments’ in Planning. You may continue to see some
EAC Adjustments for small rounding differences once the closing rate types agree. However, if the rate
types agree in Planning and how you closed the fiscal year, but there are still large EAC Adjustments,
probably subsequent changes have been made in the GL or Projects Domain. In this case, the other
Domains’ Year End Process need to be re-run and, for Costpoint versions lower than 8.1, a Planning
refresh would need to be run.

Copy Pools

If the Planning Fiscal Year Setup is set to use Target Rates, the latest Target Rate will be used for current
year and future years, until the new year’s Target Rates are entered in Costpoint Project Domain, and a
Refresh has been run. This applies to versions lower than 8.1.

If Planning has been set up to use ‘Actual’ rates, rates will not be applied until the Cost Pools in the
Project Domain are processed for the period. If the Planning rates are set to Actual, Planning will continue
to use Actuals for current and future years.

* Browse Applications > Projects > Cost and Revenue Processing > Cosi and Revenue Processing Utiliies = Copy Pools

= Identification New  Copy ¥ | Delete 10f 1 New Table | Query ¥ []— X
Parameter ID* Deseription *
Selection Ranges
Routine to copy existing pools for new fiscal year
This process may take a considerable amount of time if a large amount of data exists
Option Source Destination
Allocation Group * One 1 1
Fiscal Year* One 2018 ) 2019 )

Pool® O ) )
Options
Data To Be Copied
Pool Base Data [ Cancel processing if destination Pool Rate Data fewer than source.
Pool Cost Data
Pool Rates Data
Service Center Data
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* Browse Applications > Projects > Cost and Revenue Processing > Cost Pools > Manage Cost Pools

Identification New | Copy ¥ | Delete 1 0f 7 Existing » | M |Table | Query ¥ [ —|X
Allocation Group* 4 Primary Allocation Group ) Fiscal Year* 2019 ) Sequence Number* 1
Pool Number* 100 Pool Name * Fringe Abbreviated Name * Fringe
FDOl Details Default Accounts
Preferences
Pool Type FRINGE ) O Service Center Apply Rates to Projecls [ Unallowable [ Exclude Burden from Asset Inventory
Basis
. . Basis Type
Basis Description * Labor @ Dollars O Hours Q Units
Financial Statement Reclass Accounts
Debit Account ) Credit Account )
Pool Cost PoolBase Service Center Pool Rates
ion > Pool Rates New | Copy v | Delete | Form | Quey ¥ |[=| — 01|
- Period * Pd Actual YTD Actual Pd Target YTD Target Pd Provisional YTD Provisional Pd Cost of Money YTD Cost of Money |
12 0.000000%, 0.000000%, 41.000000% 41.000000% 41.000000%) 41.000000% 0.000000%| 0.000000%| &
1 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 41.000000% 0.000000% 0.000000% |
10 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 41.000000% 0.000000% 0.000000% ]
9 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 41.000000% 0.000000% 0.000000%
8 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 41.000000% 0.000000% 0.000000%
7 0.000000% 0.000000% 41.000000% 41.000000% 41.000000% 41.000000% 0.000000% 0.000000% | v

Close

Enter New Calendar Year-End Dates

To enter new calendar year-end dates:

1. Enter the Next Future Year into Costpoint with all the appropriate Period and Subperiod End
Dates.

Refresh Planning in versions lower than 8.1.

Validate that the Period End Dates are correct in “Maintain Fiscal Year Periods”. If they are
incorrect, you can correct them in the Planning “Maintain Fiscal Year Periods”. Once corrected,
the status will change from “FUTURE” to “OVERRIDE”.

& [ Browse Applications > ing > Administration > Admini > Maintain Fiscal Year Periods (MAMS,MAMY)

Maintain Fiscal Year Periods (MAME,MAMS) New | Gopy ¥ |Delete |Query ¥ || — || X

Il Fiscal Year * Period * Sub Period * End Date * Quarter * Statug.

v| 2019 1 1011312019 j=|R ] v OVERRIDE
2019 | 7| 1| REEE =B v |OVERRIDE
2019 3| 1031312019 =i v OVERRIDE
2019 4 1/0430/2019 2 v OVERRIDE
2019 5| 10513172019 = v OVERRIDE
2019 6 1/0630/2019 v OVERRIDE
2019 7 107312019 v OVERRIDE
2019 8 1/08312019 v OVERRIDE
2019 9 1/0ar302019 v OVERRIDE
2019 10 1103122019 v OVERRIDE
2019 11 1 1173012019 v OVERRIDE
2019 12 11213122019 v OVERRIDE

Enter a valid date. ®100% v

4. When creating an EAC, validate that the End Dates in the headings, for the current year and
future years, are correct. In an EAC, both current year and future year end dates are available to
be seen.
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= Planning > Project Budgeling >

Budget/EAC Processing >

or

* [ Browse Ap

Project Select
Project 1D * MM13

Project Budget Status

Creste BUD| Create EAC

MODIFY| COMMIT| DELETE

) Volume Test ]

o=0ajx

Form | Query ¥

Project Type Level Details

Contract Bev _ Funced Rev Distributed Rev B

Y| Projectin | Type Version  Siss | Sowce Type | SowrceVersion || Closed Period | Complete Approved Escalstion  StwiDaie | EndDate | Penods  CostType
[ana13 BUD 1 Approved ban12016 (=] [=i] 3.00% 01012016 0832018 32 DIRECT FIXED PRICE  Rev(=) Bll(=) PLC(=) 30000000 150,000.00 0.00
!MM\] |eac |n Working BUD 1 0302016 | 3.00% /01012016 [123172019 13 48| DIRECT FIXED PRICE  |Rev(=) Bll(=) PLC(=) 300,00000)  150,000.00 0.00
4 - »
Staff Hours  Stalf Escalation Materials Subcontractor Materisl Handling Travel Consultant Other Direct Costs Subcontractor Hours Consultant Hours Service Centers Re st

Project Select > Staff Hours

New

Copy v | Delete [aueny v [ =[— 0%

Project ID: MM13 Type: EAC Version: 1 Status: Working

fe * . % . S H'o<o<o1-;--<a GROIZES | OVAONITD | GAOTO4G0TY | OGU1OBO1TE | OBOTDGO0TD | OTOH-OTSTE | 001060110 | OMN 0 I
1D Type L] Hams Acct I o1 GLEPLE WrRate  Rev Bl | gseaines 11601160) (1687168 (e (1T6i184) (160182 (176/184) Pt 1160114

Employes TJEAN Aicher, Dared 05000-001 11100 [ac 000 ) [ %= - - . - " i T

Employee GOODAJ Goodfallow, Alce 05000-010 1.1.100 SA 00 M M 0.0 0.0 00 0o 00 00 00 00

Employee HACK Hack, Martin 05000-010 1.1.100 35 000 M | M 0.0 0.0 00 o0 o0 o0 00 0.0
K »[< D

Employee Schedule Emploves PLC  Advanced Search  Fill Motes
Cise

Complete Org Initialization Setup

This process can be completed at any time and for several years in the future. It is not a pre-requisite for
Year End processing. However, it must be completed for the new year before that year's Org Budget can
begin or be reported. Also, the Holiday Schedule must be set up before any Project Budgets can be

correctly calculated for that year as well.

To complete Org Initialization setup:

1.
years).

Planning >

* Browse Applications >

Organization Budgeting > Budget/Outlook Processing >

Organization Budget Cycle Initialization (AOM3)

Complete the Holiday Setup for the new year (if not already set up for use in Projects future

Organization Budget Cycle Initialization Header

Source Year* 2018

Organization Budget Gycle Initialization

Source Year 2018

Re-Glone Holiday Schedule
Clone PTO Pattemn

Re-Clone Pool Specs
Re-Freeze Employee Specs
Clone NL Percent Specs

Organization Budget Cycle Initialization Header > Holidays
Target Year: 2019
d Holiday * Description
011012019 1| ew Years Day
011022019 /| Observe New Years Day
0512972019 %1 Memorial Day
070042019 % Independance Day
0010422019 31| Labor Day
11232019 | Thanksgiving Day
120252019 1| Christmas Day

Enter Target Vear.

2.

) Target Year* 2019 )

Target Year 2019
Holiday Schedule
PTO Pattern
Pool Specs
Employes Specs
NLab % Specs
Employee Rates

Holidays PTO Pattern Pool Rates Pool Base Acct Pool Cost Acct

a—gjx

ot 1 Exitng Quey v |0 —

Legend
Required
Optional
Complete

NLAB Percent Base NLAB Percent Types

New | Copy ¥ | Delete | query v |[@|—[0 %

Close

®100% -

If using Org Budgets, complete all items in the Org Initialization for the new year. Each item

can be cloned from a prior year. Remember if you have Employee specs and pools setup in
the Target year, you can copy from the same year as the source (that is, from 2021 to 2021.
For Pool specs, copy the 2021 pool information from Costpoint to the 2021 Pool specs in

Planning).
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Browse Applications > Planning > Organization Budgeting > Budget/Outlook Processing > Organization Budget Cycle Initialization (AOM3)

Organization Budget Cycle Initialization Header

Source Year * 2018 ) Target Year* 2019 )

Organization Budget Cycle Initialization

Source Year 2018 Target Year 2019

Re-Clone Holiday Schedule Holiday Schedule
Clone PTO Pattem PTO Pattern
Re-Clone Pool Specs Pool Specs
Re-Freeze Employee Specs Employee Specs
Clone NL Percent Specs NLab % Specs

Holidays

Create Org Budgets for the New year

PTO Pattern  Pool Rates Pool Base Acct Pool Cost Acct

a—|Oojx
ot Sxming Queny v |~
Legend
Required
Optional
Complete

Employee Rates NLAB Percent Base NLAB Percent Types

f00% -

The budgets for the new year should be set up, if not already entered. These can be entered any time,

even prior to the close of the year.

An example would be, if your budget cycle requires that the Org Budget be present and reported against
as soon as January 1, then the Org initialization and budgets could be entered any time prior to January 1

of the new year.
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IRS instructions: https://www.irs.gov/pub/irs-pdf/i1099mec.pdf

IRS sample forms: https://www.irs.gov/pub/irs-pdf/f1099msc.pdf

https://www.irs.gov/pub/irs-pdf/f1099nec.pdf

9595

[ ]vOID

[ | CORRECTED

PAYER"S name, street address, city or town, state or province, country, ZIP
or foreign postal code, and telephone no.

PAYER"S TIN

RECIPIENT'S TIN

1 Rents OMB Mo. 1545-0115
% Miscellaneous
: 2021 ;

2 Royalties Information

g Form 1099-MISC

3 Other income 4 Faderal income tax withheld Cup‘y A

3 $ For

5 Fishing boat proceeds 6 Medical and health care psyments | Internal Revenue
Service Center

5

$

File with Form 1096.

RECIPIENT'S name 7 Payer mede direct sales 8 Substitute payments in lieu of For Pri\.racy Act
totaling $5,000 or more of dividends or interest P k
consumer products to and ap:erwur
racipient for resais % Reduction Act

Street address (including apt. no ) # Crop inewrance procesds | 40 Grose procesds paid to &0 Motice, see the

ultomey 2021 General
% % Instructions for
City or town, state or province, country, and ZIP or foreign postal code 11 Fish purchased for resale |12 Section 4094 deferals Cert_aln
Information
Returns.
5 5
Account number (see instructions) FATCA filing| 2nd TIN not.[13 Excess golden parechute |14 Mongualified defemsd
requirement payments compensation
O O s 4
15 State tax withheld 16 State/Payer's state no. 17 State incoms
R (SSR— I
§ $

Form 1099-MISC

Cat. No. 14425

wowrw.ire.gov/Form 1 089MISC

Department of the Treasury -

Intemal Revenue Service

Do Not Cut or Separate Forms on This Page — Do Not Cut or Separate Forms on This Page
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7171 [ voiD [] CORRECTED
PAYER'S name, street address, city or town, state or province, country, ZIP OMB Mo, 1545-0116
or foreign postal code, and telephone no.
2@)2 1 Nonemployee
Compensation
Form 1099-NEC
PAYER'S TIN RECIPIENT'S TIN 1 Honemployes compensation Copy A
5 For Internal Revenue
RECIPIENT'S nama 2 Payer made direct sales totaling $5,000 or more of Service Center
consumer products to recipeent for resale I:] Eile with Form 1006.
3 For Privacy Act and
Strest address (inchuding apt. nou Pﬁmﬁ;ﬂg&mﬁt
4 Federal income tax withheid General Instructions for
City or town, state or province, country, and ZIP or foreign postal cods % Retums.
5 State tax withheld 6 State/Payer's state no. T State income
Account number (ses instructons) 2nd T not 1§ R S
O [$ £
Form 1099-NEC Cat. No. 72590 wiww.irs.gov/Form1089NEC Department of the Traasury - Intemal Revenue Ssrvice

Do Not Cut or Separate Forms on This Page — Do Not Cut or Separate Forms on This Page
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Appendix B: Sample IRS W-2 Form

IRS instructions: https://www.irs.gov/pub/irs-pdf/iw2w3.pdf

IRS sample form: https://www.irs.gov/pub/irs-pdf/fw2.pdf

a Employee's social security number | gor official Use Only »
22222 Voo D OMB Mo. 1545-0008
b Employer identification number (EIM) 1 Wages, tips, other compensstion 2 Federal income tex withheld
¢ Employer's name, address, and ZIP code 3 Social security wages 4 Social security tax withheld
5 Medicare wages and tips 6 Medicare tax withhed
7 Social security tips 8 Allocated tips
d Control number k] 10 Dependent cars benefits
e Employea's first name and initial Last name Suff. | 41 Nonguakfied plans !25 See instructions for box 12
i
13 EHI“‘WU 'F;I:I:ﬁllﬂ B:l:::l. !zh
o ] f: |
14 Other !2::
i
12d
cC
i
f Employese's eddress end ZIP code
15 State  Employer's state 1D number 16 State wages, tips, eto. [ 17 State income tax 18 Local wages, tips, etc. | 18 Local imcome tax 20 Locality nama

Department of the Treesury— Internal Revenue Service
Form w-z wage and Tax Statement E D E 1' For Privacy Act and Paparwnr_k Hm:lug:tlon
Copy A—For Social Security Administration. Send this entire page with Act Notice, see the separats inatructiona.
Form W-3 to the Social Security Administration; photocopies are not acceptable. Cat. No. 101340

Do Not Cut, Fold, or Staple Forms on This Page
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About Deltek

Better software means better projects. Deltek delivers software and information solutions that enable
superior levels of project intelligence, management and collaboration. Our industry-focused expertise
makes your projects successful and helps you achieve performance that maximizes productivity and
revenue. www.deltek.com
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